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Regulatory Compliance

Thermo Fisher Scientific performs complete testing and evaluation of its products to ensure full compliance with 
applicable domestic and international regulations. When the system is delivered to you, it meets all pertinent 
electromagnetic compatibility (EMC) and safety standards as described in the next section or sections by product name.

Changes that you make to your system may void compliance with one or more of these EMC and safety standards. 
Changes to your system include replacing a part or adding components, options, or peripherals not specifically 
authorized and qualified by Thermo Fisher Scientific. To ensure continued compliance with EMC and safety standards, 
replacement parts and additional components, options, and peripherals must be ordered from Thermo Fisher Scientific 
or one of its authorized representatives.

EMC Directive 89/336/EEC as amended by 92/31/EEC and 93/68/EEC

EMC compliance has been evaluated by UNDERWRITERS LABORATORY, INC (UL).

Low-Voltage Safety Compliance

This device complies with the EU directive 73/23/EEC (equivalent to IEC 1010-1, 1990 plus Amendment 1, 1991 
and Amendment 2, 1995) by meeting the following standard: EN 61010-1: 2001 with Corrigendum No. 1 and 2.

FCC Compliance Statement

EN 55011 (1998) EN 61000-4-3 (2002)

EN 61326-1 (1998) EN 61000-4-4 (2001)

EN 61000-3-2 1995 EN 61000-4-5 (2001)

EN 61000-3-3 1995 EN 61000-4-6 (2001)

EN 61000-4-2 (2001) EN 61000-4-11 (2001)

CFR 47 Part 15 Subpart B: 2004
Code of Federal Regulations, Part 15, Subpart B, Radio Frequency Devices Unintentional Radiators 
Class A

THIS DEVICE COMPLIES WITH PART 15 OF THE FCC RULES. OPERATION IS SUBJECT TO 
THE FOLLOWING TWO CONDITIONS: (1) THIS DEVICE MAY NOT CAUSE HARMFUL 
INTERFERENCE, AND (2) THIS DEVICE MUST ACCEPT ANY INTERFERENCE RECEIVED, 
INCLUDING INTERFERENCE THAT MAY CAUSE UNDESIRED OPERATION.



Notice on Lifting and Handling of
Thermo Scientific Instruments

For your safety, and in compliance with international regulations, the physical handling of this Thermo Fisher Scientific 
instrument requires a team effort to lift and/or move the instrument. This instrument is too heavy and/or bulky for one 
person alone to handle safely.

Notice on the Proper Use of
Thermo Scientific Instruments

In compliance with international regulations: Use of this instrument in a manner not specified by Thermo Fisher 
Scientific could impair any protection provided by the instrument.

Notice on the Susceptibility 
to Electromagnetic Transmissions

Your instrument is designed to work in a controlled electromagnetic environment. Do not use radio frequency 
transmitters, such as mobile phones, in close proximity to the instrument.

For manufacturing location, see the label on the instrument.

CAUTION Read and understand the various precautionary notes, signs, and symbols contained inside 
this manual pertaining to the safe use and operation of this product before using the device.



WEEE Compliance

This product is required to comply with the European Union’s Waste Electrical & Electronic Equipment (WEEE) 
Directive 2002/96/EC. It is marked with the following symbol:

Thermo Fisher Scientific has contracted with one or more recycling or disposal companies in each European Union 
(EU) Member State, and these companies should dispose of or recycle this product. See www.thermo.com/
WEEERoHS for further information on Thermo Fisher Scientific’s compliance with these Directives and the 
recyclers in your country.

WEEE Konformität

Dieses Produkt muss die EU Waste Electrical & Electronic Equipment (WEEE) Richtlinie 2002/96/EC erfüllen.  
Das Produkt ist durch folgendes Symbol gekennzeichnet:

Thermo Fisher Scientific hat Vereinbarungen mit Verwertungs-/Entsorgungsfirmen in allen EU-Mitgliedsstaaten 
getroffen, damit dieses Produkt durch diese Firmen wiederverwertet oder entsorgt werden kann. Mehr Information 
über die Einhaltung dieser Anweisungen durch Thermo Fisher Scientific, über die Verwerter, und weitere Hinweise, 
die nützlich sind, um die Produkte zu identifizieren, die unter diese RoHS Anweisung fallen, finden sie unter  
www.thermo.com/WEEERoHS. 

http://www.thermo.com/WEEERoHS
http://www.thermo.com/WEEERoHS
http://www.thermo.com/WEEERoHS
http://www.thermo.com/WEEERoHS


Conformité DEEE

Ce produit doit être conforme à la directive européenne (2002/96/EC) des  Déchets d'Equipements Electriques et 
Electroniques (DEEE). Il est marqué par le symbole suivant:

Thermo Fisher Scientific s'est associé avec une ou plusieurs compagnies de recyclage dans chaque état membre de 
l’union européenne et ce produit devrait être collecté ou recyclé par celles-ci. Davantage d'informations sur la 
conformité de Thermo Fisher Scientific à ces directives, les recycleurs dans votre pays et les informations sur les 
produits Thermo Fisher Scientific qui peuvent aider la détection des substances sujettes à la directive RoHS sont 
disponibles sur www.thermo.com/WEEERoHS. 

http://www.thermo.com/WEEERoHS
http://www.thermo.com/WEEERoHS
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P

Preface

This MSQ Plus Mass Detector Getting Started Guide explains how to set up, calibrate, and tune 
the MSQ™ Plus Mass Detector and how to acquire LC/MS data. 

This manual supports the release of the MSQ 2.0 instrument software shipped with the 
Xcalibur™ 2.0 or later data system.

Related Documentation
In addition to this guide, Thermo Fisher Scientific provides the following documents as PDF 
files for the MSQ Plus Mass Detector:

• MSQ Plus Mass Detector Hardware Manual

• MSQ Plus Mass Detector Getting Connected Guide

• MSQ Plus Mass Detector Preinstallation Guide

• MSQ Plus Mass Detector Calmix Kit Preparation Guide

The software also provides Help.

To suggest changes to documentation or to Help

Complete a brief survey about this document by clicking the link below.
Thank you in advance for your help.

Safety and Special Notices
Make sure you follow the precautionary statements presented in this guide. The safety and 
other special notices appear in boxes.
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Safety Precautions
Safety and special notices include the following:

Safety Precautions
Observe the following safety precautions when you operate or perform service on the MSQ 
Plus Mass Detector:

Do not perform any servicing other than that contained in the MSQ Plus Mass Detector 
Hardware Manual. To avoid personal injury or damage to the instrument, do not perform 
any servicing other than that contained in the MSQ Plus Mass Detector Hardware Manual or 
related manuals unless you are qualified to do so.

Shut down the mass detector and disconnect it from line power before you service it. 
High voltages capable of causing personal injury are used in the instrument. Some 
maintenance procedures require that the mass detector be shut down and disconnected from 
line power before service is performed. Do not operate the mass detector with the top or side 
covers off. Do not remove protective covers from PCBs.

Do not interfere with the safety interlock. Interfering with the safety interlock will expose 
you to potentially lethal electrical hazards.

Respect heated zones. Treat heated zones with respect. The ion transfer capillary and the 
APCI vaporizer might be very hot and might cause severe burns if touched. Allow heated 
components to cool before you service them.

Place the mass detector in Standby (or Off ) before you open the atmospheric pressure 
ionization (API) source. The presence of atmospheric oxygen in the API source when the 
mass detector is on could be unsafe. The mass detector automatically goes into Standby when 
you open the API source; however, take this added precaution for safety reasons.

Take care when handling the corona pin. The corona pin is sharp and can cause personal 
injury. Take care when removing or installing the corona pin.

CAUTION  Highlights hazards to humans, property, or the environment. Each CAUTION 
notice is accompanied by an appropriate CAUTION symbol. 

IMPORTANT  Highlights information necessary to prevent damage to software, loss of 
data, or invalid test results; or might contain information that is critical for optimal 
performance of the system.

Note  Highlights information of general interest.

Tip  Highlights helpful information that can make a task easier.
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Contacting Us
Make sure you have sufficient nitrogen for your API source. Before you begin normal 
operation each day, make sure that you have sufficient nitrogen for your API source. The 
presence of atmospheric oxygen in the API source when the mass detector is on could be 
unsafe. The mass detector automatically goes into Standby when you run out of nitrogen; 
however, take this added precaution for safety reasons.

Contain waste streams. Because the API source can accommodate high solvent flow rates, 
you must make provisions to collect the waste solvent. 

Provide adequate fume exhaust systems for the API source solvent waste container and 
the forepump. Your laboratory must be equipped with at least two fume exhaust systems: one 
to vent the waste container connected to the exhaust port (API solvent drain) on the back of 
the mass detector and the other to vent the forepump exhaust. As described in the MSQ Plus 
Mass Detector Getting Connected Guide, route the (blue) forepump exhaust hose to a dedicated 
fume exhaust system. Because the exhaust hose acts as a trap for exhaust fumes that would 
otherwise recondense in the forepump oil, the hose should travel at floor level for a minimum 
of two meters (78.5 in.) before it reaches the external exhaust system. Route tubing from the 
waste container connected to the exhaust port on the back of the mass detector to a second 
dedicated fume exhaust system. Consult local regulations for the proper method of exhausting 
the fumes from your system. 

Do not vent the PVC drain tube (or any vent tubing connected to the waste container) to the 
same fume exhaust system that is connected the forepump. The forepump exhaust contains 
pump oil, which can seriously contaminate the analyzer optics of the mass spectrometer.

Contacting Us
There are several ways to contact Thermo Fisher Scientific for the information you need. 

To contact Technical Support

Find software updates and utilities to download at mssupport.thermo.com.

To contact Customer Service for ordering information

Phone 800-532-4752

Fax 561-688-8736

E-mail us.techsupport.analyze@thermofisher.com

Knowledge base www.thermokb.com

Phone 800-532-4752

Fax 561-688-8731

E-mail us.customer-support.analyze@thermofisher.com
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Contacting Us
To copy manuals from the Internet

Go to mssupport.thermo.com and click Customer Manuals in the left margin of the 
window. 

To suggest changes to documentation or to Help

• Fill out a reader survey online at 
http://www.surveymonkey.com/s.aspx?sm=R7gKOvhLXn3NTkpK2BefHQ_3d_3d.

• Send an e-mail message to the Technical Publications Editor at 
techpubs-lcms@thermofisher.com.

Web site www.thermo.com/ms
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Introduction

This chapter explains the basic functionality of the MSQ Plus Mass Detector and the 
preparations for using the tool.

The MSQ Plus Mass Detector is a high-performance single-quadrupole mass spectrometer. It 
includes a reference inlet system, an atmospheric pressure ionization (API) source, and the 
Xcalibur data system. The reference inlet system is used for autotuning and mass-scale 
calibration. 

In liquid chromatography mass spectrometry (LC/MS) analysis, an autosampler injects a 
sample onto an LC column. The sample separates into its various components. The 
components elute from the LC column and pass into the mass detector, where they are 
analyzed. The Xcalibur data system then stores and processes the data from the mass detector. 

Why Use the MSQ Plus Mass Detector?
The MSQ Plus Mass Detector can increase the specificity and detection limits for applications 
that use any of the classic detectors, such as UV, fluorescence, light-scattering, or refractive 
index. Applications using classic detectors rely primarily on chromatographic retention times 
to identify analytes. In contrast, a mass detector allows mass identification for the components 
of chromatographic peaks.

Contents

• Why Use the MSQ Plus Mass Detector?

• Is ESI or APCI Better for Analyzing My Samples?

• How Do I Introduce My Samples into the Mass Detector?

• What Types of Buffers Can I Use?

• How Do I Set Up the Mass Detector for Various LC Flow Rates?

• How Do I Calibrate the MSQ Plus Mass Detector?

• How Do I Optimize the Mass Detector Parameters for My Analytes?

• How Do I Create Instrument Control Methods?
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Why Use the MSQ Plus Mass Detector?
A mass detector consists of an ion source, a mass analyzer, a vacuum system, and an ion 
detector. The ion source performs four functions: it separates the analytes from the solvent 
molecules, it ionizes the analytes, it drives the ionized solutes from the liquid phase to the gas 
phase, and it provides efficient transfer of the ions to the mass analyzer. The vacuum system 
provides the driving force for drawing ions into the mass analyzer and the environment in 
which the ions can reach the detector without colliding with other gaseous molecules. The 
mass analyzer produces an electric field or a magnetic field or both that allow only ions within 
a specified mass-to-charge range to reach the ion detector. The ion detector detects the 
presence of ions as they exit the mass analyzer.

The MSQ Plus Mass Detector performs two types of complementary atmospheric pressure 
ionization: electrospray ionization (ESI) and atmospheric pressure chemical ionization 
(APCI). It uses a transfer lens to transmit ions to the mass analyzer. The mass analyzer consists 
of a single round quadrupole with an upper mass range limit of 2000 u at unit resolution. The 
vacuum system consists of an external forepump and an internal turbomolecular pump. The 
external forepump operates from atmospheric pressure down to 10-3 torr and handles high gas 
loads of approximately 30 m3/h at 1 torr. The internal turbomolecular pump provides a high 
vacuum of 10-6 torr. The ion detector is a conversion dynode, which allows a time interval of 
200 milliseconds for switching between positive and negative polarity modes.

The MSQ Plus Mass Detector measures only 30 cm (12 in.) wide and integrates seamlessly 
with the Accela™ LC system. The following new innovations for this mass detector make it 
ideal for the chromatographer:

• ESI and APCI FastLoc™ probes, which allow you to switch between the two ionization 
modes in less than a minute 

• Wipe-clean, M-Path™ ion source with a patented cone wash system for ultra-rugged 
performance with non-volatile phosphate buffers

• Automated full-system autotune

• Interactive method setup with 10 built-in editable templates

The M-Path source and the cone wash system allow you to use mobile phases that would 
ordinarily be prohibited because of their tendency to clog the entrance cone of the ion source. 
The positioning of the probe insert directs non-volatile components, such as those from 
mobile-phase buffers and ion-pairing agents or sample matrices, away from the orifice of the 
entrance cone. A low flow of solvent (100 to 250 μL/min) from the cone wash system 
spraying the edge of the entrance orifice helps to prevent a build-up of non-volatiles during an 
LC/MS run.

The tuning and calibration process that is required for all quadrupole mass analyzers to 
optimize their mass range, mass accuracy, and mass resolution is completely automated with 
wizards. Figure 1 shows the user interface for these wizards. The service engineer tunes and 
calibrates the detector at installation. Perform an automated mass scale calibration whenever 
you notice a drift in the accuracy of the reported masses of your known standards.
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Is ESI or APCI Better for Analyzing My Samples?
Figure 1. Instrument Tuning and Calibration wizard

To create an acquisition method for an LC/MS system with an MSQ Plus Mass Detector, use 
the Tune window to optimize the parameters for your analyte. After determining the optimal 
mass detector settings for your analyte, open a template from the Instrument Setup window, 
import the Tune file that contains the optimal settings for your analyte, and modify a few 
parameters, if necessary. 

Is ESI or APCI Better for Analyzing My Samples?
You can operate the MSQ Plus Mass Detector in either of two atmospheric pressure 
ionization modes: electrospray ionization (ESI) or atmospheric pressure chemical ionization 
(APCI).

Typically, polar compounds such as amines, peptides, and proteins are best analyzed by ESI, 
and non-polar compounds such as steroids are best analyzed by APCI.

Sample ions can carry a single charge or multiple charges. The number of charges carried by 
the sample ions depends on the structure of the analyte of interest, the mobile phase, and the 
ionization mode.
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Is ESI or APCI Better for Analyzing My Samples?
Electrospray Ionization (ESI)

ESI mode generally produces mass spectra consisting of singly charged ions, but it depends on 
the structure of the analyte and the solvent. When multiply charged ions are produced, the 
Xcalibur data system can mathematically transform the resulting mass spectrum to express the 
molecular weight of the sample.

ESI mode transfers ions in solution into the gas phase. Because the ESI process does not use 
heat to nebulize the analyte ions, you can use it to analyze heat-labile compounds or 
high-molecular-weight compounds. 

You can use ESI mode to analyze any polar compound that makes a preformed ion in 
solution. Preformed ions can include adduct ions. For example, polyethylene glycols can be 
analyzed from a solution containing ammonium acetate because of adduct formation between 
the NH4

+ ions in the solution and oxygen atoms in the polymer. With ESI, the MSQ Plus 
Mass Detector can analyze compounds with molecular weights that are greater than 100000 u 
because of multiple charging. ESI is especially useful for the mass analysis of polar 
compounds, which include biological polymers (for example, proteins, peptides, 
glycoproteins, and nucleotides), pharmaceuticals and their metabolites, and industrial 
polymers.

You can use ESI mode in either the positive- or negative-ion polarity mode. Matching the 
charge on the ESI probe to the charge on the preformed ions in solution increases the 
sensitivity of the analysis. Therefore, select the ion polarity mode according to the polarity of 
the preformed ions in solution. Acidic molecules form negative ions in high pH solution, and 
basic molecules form positive ions in low pH solution.

You can vary the flow rate in ESI mode from the LC into the mass detector from 10 μL/min 
to 2000 μL/min. (In ESI, the buffer type and the buffer strength both have a noticeable effect 
on sensitivity. Therefore, it is important to choose these variables correctly.) In the case of 
higher-molecular-weight proteins or peptides, the resulting mass spectrum typically consists 
of a series of peaks corresponding to a distribution of multiply charged analyte ions.

The droplet size, surface charge, liquid surface tension, solvent volatility, and ion solvation 
strength all affect the ESI process. Large droplets with high surface tension, low volatility, 
strong ion solvation, low surface charge, and high conductivity prevent good electrospray.

Mixed organic-aqueous solvent systems that include organic solvents, such as methanol, 
acetonitrile, and isopropyl alcohol, are superior to water alone for ESI. Volatile acids and bases 
are good, but Thermo Fisher Scientific does not recommend salts above 10 mM. Strong 
mineral acids and bases are extremely detrimental to the instrument.

Observe the following recommendations for generating stable electrospray:

• Refrain from using non-volatile salts and buffers in the solvent system. For example, avoid 
the use of salts containing sodium or potassium and avoid the use of phosphates. 
If necessary, use ammonium salts instead.

• Use organic-aqueous solvent systems.
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How Do I Introduce My Samples into the Mass Detector?
• Use volatile acids and bases.

• If possible, optimize the pH of the solvent system for your analyte of interest. For 
example, if your analyte of interest contains a primary or secondary amine, use an acidic 
mobile phase (pH 2 to 5) for your chromatographic separation. The acidic pH tends to 
keep positive ions in solution.

Atmospheric Pressure Chemical Ionization (APCI)

Like ESI, APCI is a soft ionization technique, as opposed to an electron ionization technique. 
APCI provides molecular weight information for compounds of low polarity that are 
somewhat volatile. APCI is typically used to analyze small molecules with molecular weights 
up to about 1000 u.

APCI is a gas-phase ionization technique. Therefore, the gas phase acidities and basicities of 
the analyte and solvent vapor play an important role in the APCI process.

In APCI mode, you can vary the flow rate from the LC into the mass detector from 0.2 to 
2 mL/min.

You can use APCI in positive- or negative-ion polarity mode. Molecules with basic sites 
produce a strong ion current in positive ion mode. Molecules with acidic sites, such as 
carboxylic acids and acid alcohols, produce a strong ion current in negative-ion mode.

Although, in general, fewer negative ions are produced than positive ions, the negative ion 
polarity mode can be more specific, because the negative ion polarity mode typically generates 
less chemical noise than does the positive mode. Therefore, the signal-to-noise ratio might be 
better in the negative ion mode than in the positive ion mode.

How Do I Introduce My Samples into the Mass Detector?
Use an LC system containing an LC pump and an autosampler to introduce samples into the 
MSQ Plus Mass Detector. The MSQ Plus Mass Detector has a reference inlet system for the 
introduction of the tuning and mass scale calibration solution.

The Xcalibur data system controls HPLC systems manufactured by Thermo Fisher Scientific 
and other manufacturers. The Accela LC system manufactured by Thermo Fisher Scientific 
integrates seamlessly with the MSQ Plus Mass Detector. 
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What Types of Buffers Can I Use?
What Types of Buffers Can I Use? 
Use volatile buffers, when possible, to obtain the highest performance for your assays. Volatile 
buffers include the following:

• Acetic acid

• Ammonium acetate

• Ammonium formate

• Ammonium hydroxide

• Triethylamine (TEA)

• Trifluoroacetic acid (TFA)

Some LC applications use non-volatile buffers, such as phosphate or borate buffers. However, 
the use of non-volatile buffers can lead to a buildup of salt in the ion source and can cause a 
loss of sensitivity. 

For LC applications that require non-volatile buffers, Thermo Fisher Scientific recommends 
installing the optional cone wash pump.

How Do I Set Up the Mass Detector for Various LC Flow Rates?
The ESI probe can generate ions from liquid flows of 10 μL/min to 2.0 mL/min. This flow 
rate range lets you use a variety of separation techniques: capillary LC, microbore LC, and 
analytical LC. The APCI probe can generate ions from liquid flows of 0.2 to 2.0 mL/min. 
Within this flow rate range, you can use the microbore LC, analytical LC, and 
semi-preparative LC separation techniques.

As you change the solvent flow rate entering the mass detector, adjust the mass detector 
parameters:

• For ESI mode, adjust the probe temperature and the needle voltage.

• For APCI mode, adjust the probe temperature and the corona current.

Note  You might need to increase the frequency of ion source maintenance when using 
non-volatile buffers.

CAUTION  Do not heat the probe without the nitrogen gas flowing. To prepare the mass 
detector for operation, turn on the nitrogen gas, turn on the probe heater, and then turn 
on the LC flow. After you finish an analysis, turn off the LC flow, turn off the heater, and 
then turn off the nitrogen gas.
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How Do I Calibrate the MSQ Plus Mass Detector?
In general, increase the probe temperature as you increase the flow rate from the LC pump. 
Table 1 and Table 2 list the suggested starting probe temperatures for optimizing an analysis 
in ESI mode or APCI mode, respectively. You might find that the optimal probe temperature 
for your analysis differs from these values by as much as 50 °C.

How Do I Calibrate the MSQ Plus Mass Detector?
The MSQ Plus Mass Detector includes a comprehensive autotune system that offers two 
levels of instrument calibration: full-system autotune and mass-scale calibration.

When installing the system, the Thermo Fisher Scientific service engineer performs a 
full-system autotune, which includes a mass-scale calibration. After receiving a full-system 
autotune, the mass detector is extremely stable in the region of 0.01 u/°C. In a normal 
air-conditioned laboratory, the mass detector rarely, if ever, needs a second full-system 
autotune. 

A deep tune is an automated operation that adjusts the operating frequency of the RF 
generator to match the natural resonant frequency of the quadrupole analyzer. It ensures that 
the mass detector operates to the maximum value of its mass range.

Resolution set-up is an automated operation that electronically adjusts the resolution of the 
peaks produced by the calibrant at both high and low mass (1971.6 m/z and 172.8 m/z, 
respectively). It is adjusted to give unit resolution by setting the peak width to 0.7 u at the half 
height of the peak. It also performs a linearity adjustment to the same criterion at mid mass 
(1072.24 m/z).

Table 1. Starting probe temperature values for ESI mode

Flow rate Temperature

200 μL/min 350 °C

500 μL/min 450 °C

1000 μL/min 575 °C

2000 μL/min 650 °C

Table 2. Starting probe temperature values for APCI mode

Flow rate Temperature 

200 μL/min 450 °C

500 μL/min 550 °C

1000 μL/min 650 °C

2000 μL/min 650 °C
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How Do I Optimize the Mass Detector Parameters for My Analytes?
Mass-scale calibration is an automated procedure that compares the masses of the 
factory-supplied calibrant solution to a reference file of the same compound. The reference 
file contains the correct mass for each peak and the values of the acquired data file are 
corrected to match those in the reference file. These correction factors are then applied to all 
subsequent acquisitions. 

Perform a full-system autotune when you do the following:

• Move the mass detector to a different environment.

• Perform maintenance on the source block.

• Install or update the Xcalibur software. 

Perform a mass-scale calibration if you notice a small drift in mass accuracy.

A full-system autotune does the following:

1. Resets all tune parameters to their default values.

2. Performs a deep tune.

3. Performs a resolution set-up.

4. Performs a mass-scale calibration.

The default tune parameters for your MSQ Plus Mass Detector are set at the factory. 

For information on tuning and calibrating the MSQ Plus Mass Detector, see “Calibrating the 
MSQ Plus Mass Detector” on page 23.

How Do I Optimize the Mass Detector Parameters for My Analytes?
Optimize the run acquisition parameters for your MSQ Plus Mass Detector from the Tune 
window. For ESI mode, optimize the probe temperature, needle voltage, and cone voltage. For 
APCI mode, optimize the probe temperature, corona current, and cone voltage. 

The optimization procedure requires the use of an LC system containing both an LC pump 
and an autosampler. The autosampler introduces your sample into the solvent flow produced 
by the LC pump. An LC column is not required for this procedure. However, because LC 
pumps require a minimum backpressure of 3 bar (40 psi) for optimal performance, you might 
need to connect a backpressure regulator between the LC outlet and mass detector inlet.

After you optimize these settings in the Tune window, save them in a tune file. When you 
create an instrument method, import the tune file into the Method Editor. 

The Xcalibur data system imports these parameters with the tune file:

• Needle voltage or corona current

• RF lens bias
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How Do I Create Instrument Control Methods?
• Ion energy

• Low-mass resolution

• High-mass resolution

You cannot modify the RF lens bias, ion energy, low-mass resolution, and high-mass 
resolution parameters.  The correct values are embedded when you use any of the following 
files as a template for optimization: the esipos.tune, esineg.tune, apcipos.tune, or apcineg.tune 
file. 

After you import the tune file into the Method Editor, you must manually enter the optimal 
probe temperature and cone voltages for your application. 

For information on creating tune files for ESI experiments, see “Manual Tuning in ESI Mode” 
on page 39. For information on creating tune files for APCI experiments, see “Manual Tuning 
in the APCI Mode” on page 47. For information on creating instrument methods, see 
“Creating Instrument Methods” on page 57.

How Do I Create Instrument Control Methods?
Create instrument methods, which control all the modules of your LC/MS instrument, from 
the Xcalibur Instrument Setup window. You manually enter the parameters for the modules of 
your instrument, with the exception of either the needle voltage or the corona current value 
for the MSQ Plus Mass Detector.

For ESI mode, import a tune (.tune) file that contains the appropriate needle voltage for your 
application. For APCI mode, import a tune (.tune) file that contains the appropriate corona 
current for your application. 

The Use Current Tune file check box is selected by default, as shown in Figure 2. This means 
that the mass detector uses the needle voltage or the corona current value in the current tune 
file. To use the needle voltage value or the corona current value from a stored tune file, you 
must deselect this check box, click the Browse button to the right of the Use Selected Tune 
File box, and select an appropriate tune file.
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How Do I Create Instrument Control Methods?
Figure 2. MSQ Plus Method Editor dialog box

For information on making automated injections, consult the following chapters in this 
manual:

• For information on creating tune files for ESI experiments, see “Manual Tuning in ESI 
Mode” on page 39.

• For information on creating tune files for APCI experiments, see “Manual Tuning in the 
APCI Mode” on page 47.

• For information on creating instrument methods, see “Creating Instrument Methods” on 
page 57.

• For information on creating a sequence spreadsheet to automate the injection of a set of 
samples, see “Creating and Running Sequences” on page 75.

Use current tune file 
check box

Browse button
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2

Configuring Your LC/MS Instrument

This chapter describes how to configure your LC/MS instrument.

The typical inlet for the MSQ Plus Mass Detector is a liquid chromatograph. The Xcalibur 
2.0 data system supports liquid chromatography systems manufactured by Thermo Fisher 
Scientific and other manufacturers. 

During installation, a Thermo Fisher Scientific service engineer will connect your MSQ Plus 
Mass Detector and a supported liquid chromatograph. In addition, the service engineer will 
add these supported devices to your Xcalibur instrument configuration. To modify your 
LC/MS instrument, refer to the MSQ Plus Mass Detector Getting Connected Guide for 
instructions on connecting the modules of a liquid chromatograph to your MSQ Plus Mass 
Detector. 

Various configuration options are available for each of the supported liquid chromatographs. 
In addition, you can specify the serial number and a location code, company asset ID, or 
custom label for the MSQ Plus Mass Detector. Before you operate your system, verify that 
your instrument contains the appropriate configuration settings.

Configuring the Mass Detector
You can track the serial number of the MSQ Plus Mass Detector used in experiments by 
entering its serial number in the MSQ Plus Configuration dialog box. The serial number 
appears in the autotune report.

To add the MSQ Plus Mass Detector to your instrument configuration 

1. From the Windows taskbar, depending on the data system version, do one of the 
following:

• For Xcalibur 2.0.7, choose Start > Programs > Xcalibur > Instrument 
Configuration.

The Instrument Configuration application appears.

Contents

• Configuring the Mass Detector

• Configuring the LC System
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Configuring the Mass Detector
–or–

• For Xcalibur 2.1.x, choose Start > Programs >Thermo Foundation 1.0 > 
Instrument Configuration.

The Thermo Foundation Instrument Configuration dialog box appears, as shown in 
Figure 3.

Figure 3. Thermo Foundation Instrument Configuration dialog box 

2. If the MSQ Plus Mass Detector is not shown in the Configured Devices list, scroll down 
through the devices shown in the Available Device list. Double-click the MSQ Plus 
button to copy it to the Configured Devices list. 

3. Double-click the MSQ Plus icon in the Configured Devices pane to open the MSQ Plus 
Configuration dialog box, shown in Figure 4.

Note  The Instrument Configuration application has the same functionality as 
the Thermo Foundation Instrument Configuration dialog box. 
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Configuring the LC System
Figure 4. MSQ Plus Configuration dialog box

4. (Optional) To enter the serial number of the mass detector, click in the Serial number 
box, and then type the serial number. 

The serial number is located on the back of the MSQ Plus Mass Detector.

5. (Optional) To enter user-defined information, select or type a value of up to 20 characters 
in the Label box. 

The available selections are Company Asset ID and Location code. 

6. Type a value of up to 20 characters for the location code, company asset ID, or 
user-defined label in the Value box. 

7. Click OK to close the MSQ Plus Configuration dialog box. 

8. Complete the configuration of your LC/MS system, and then click Done to exit the 
Instrument Configuration application. 

Configuring the LC System
If your LC system is controlled from the Xcalibur data system, you must add it or all of its 
devices to your instrument configuration.

To add your LC system to the instrument configuration for your data system

1. If a particular device is not listed in the Configured Devices pane in the Instrument 
Configuration dialog box, double-click its icon in the Available Devices pane to add it to 
the Configured Devices pane.

2. Double-click each device in the Configured Device pane and check its configuration 
settings. 
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Configuring the LC System
Information on the configuration settings for each device is available in the Help. For 
additional information about your Accela LC system, refer to the Accela Getting Started 
with Xcalibur 2.0 Guide or the Accela Xcalibur 2.1.x User Guide.
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3

Preparing Your LC/MS for Operation

This chapter describes how to prepare your LC/MS instrument for operation. Check the 
system before restarting its operation by performing the procedures in this chapter.

Checking the Hardware
First, check the hardware of your mass detector and your LC system.

To check the hardware of the mass detector and the LC system

1. Verify that the power, communication, and nitrogen supply lines are correctly connected. 
For instructions on connecting the MSQ Plus Mass Detector, refer to the MSQ Plus Mass 
Detector Getting Connected Guide.

2. Check that the LC system is properly connected.

Instructions for connecting a Thermo Scientific LC are included in the manuals stored on 
the LC devices CD that is part of the media kit. For detailed instructions on connecting 
an Accela LC system, refer to the Accela Getting Connected Guide. 

3. Verify that the nitrogen gas supply for the mass detector is adequate.

The MSQ Plus Mass Detector uses a maximum of 720 L/h in ESI mode.

4. Verify that the nitrogen regulator is set to 5.2 bar (75 psi) for ESI mode or 3.1 bar 
(45 psi) for APCI mode. 

The nitrogen regulator, shown in Figure 5, is located below the source compartment of 
the mass detector.

Contents

• Checking the Hardware

• Checking the Status of the LC/MS Instrument

• Checking the Oil Level in the Oil Mist Filter and the Forepump

• Preparing the LC for Operation
Thermo Scientific MSQ Plus Mass Detector Getting Started Guide 15



3 Preparing Your LC/MS for Operation
Checking the Status of the LC/MS Instrument
Figure 5. Nitrogen regulator

5. Verify that the hard drive on your data system computer contains sufficient storage space.

Checking the Status of the LC/MS Instrument
If the MSQ Plus Mass Detector has not been in use recently, it might be in one of four 
possible states:

• The system might be under vacuum with the nitrogen gas flowing.

• The system might be in Off mode, which means that the nitrogen flow is reduced to a 
bleed through the API probe, the electron multiplier and conversion dynode are turned 
off, the power to the ion optics is turned off, and the power to the probe heater is turned 
off, but the system is still under vacuum.

• The system might be vented, which means it is no longer under vacuum.

• The system might not be connected.

During typical usage, the MSQ Plus Mass Detector is either left on, with the nitrogen 
flowing, or off, with both the nitrogen flow and probe heater turned off. The forepump is 
always left powered on, and the source is always left under vacuum. If the system has been 
moved or has been left unused for several months, it might be vented or powered off. For 
instructions on pumping down a vented system, refer to the MSQ Plus Mass Detector 
Hardware Manual. 

Note  Anti-virus software uses a large portion of your computer’s memory as it scans 
the hard drive for viruses. Ensure that the anti-virus software is not set to perform a 
scan while you are acquiring data. 

The Xcalibur data system does not include anti-virus software.

Pressure 
gauge

Control 
dial
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Checking the Status of the LC/MS Instrument
For information about the status of the MSQ Plus Mass Detector, use the Server icon, shown 
in Figure 6, and the Information view of the Xcalibur data system, shown in Figure 7. The 
server software handles the communication between the MSQ Plus Mass Detector and the 
Xcalibur data system. The Xcalibur data system controls the modules of your LC/MS system. 

Figure 6. Server icon

Figure 7. Xcalibur Roadmap view

The Server icon shown in Figure 6 mimics a tristate LED display (red, green, yellow). Its 
states have the following meanings:

• Steady red when the power is on and the instrument is vented or an error has occurred 
within the system

• Flashing yellow when the instrument is pumping down

Note  Do not vent the system unless you plan to move the MSQ Plus Mass Detector, 
perform maintenance on an internal component of the system, or leave the system unused 
for a period of several months.

Server icon

Roadmap 
view

Information 
view
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• Steady yellow when the instrument is pumped down but not in Operate mode

• Steady green when the instrument is pumped down and in Operate mode

To check the status of your LC/MS instrument

1. Launch the Xcalibur data system by doing one of the following:

• From the Windows desktop, double-click the Xcalibur icon, . 

–or–

• For the Xcalibur 2.0.x data system, choose Start > Programs > Thermo Xcalibur > 
Xcalibur from the Windows taskbar.

–or–

• For the Xcalibur 2.1.x data system, choose Start > Programs > Thermo Xcalibur > 
Xcalibur.

The data system opens to the Thermo Xcalibur Roadmap view, shown in Figure 7. If your 
instrument configuration contains an MSQ Plus Mass Detector, the Server icon appears 
in the system tray of the Windows taskbar next to the time display. 

If the Server icon does not appear when you start the data system, check the configuration 
of your instrument and the USB cable connection to the MSQ Plus Mass Detector. You 
do not need to add specific configuration information for the MSQ Plus Mass Detector, 
but you do have to add the mass detector to your instrument configuration. Refer to 
“Configuring Your LC/MS Instrument” on page 11 and the Help for information on 
configuring your instrument.

2. If the Information view is not displayed, click the Info View icon, , in the toolbar to 
display it.

Figure 7 shows the Status page of the Information view on the Roadmap view for an 
LC/MS instrument that includes an Accela autosampler, an Accela pump, and an MSQ 
Plus Mass Detector.

3. Click the listing of each configured device to display its status in the lower portion of the 
Status page.

Checking the Oil Level in the Oil Mist Filter and the Forepump
The forepump is external to the MSQ Plus Mass Detector and requires routine maintenance 
to keep it running at its optimum performance level.

Note  You can find more information on operating and maintaining the forepump in the 
manual that accompanies it. 
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Checking the Oil Level in the Oil Mist Filter and the Forepump
As oil is vaporized by the forepump during normal operation, the oil mist filter fills with 
condensed oil. In addition, the oil in the forepump becomes contaminated with volatile 
solvents, which can cause corrosion and reduce the lifetime of the forepump. Once the oil 
level in the oil mist filter rises above the maximum oil level mark, the oil mist filter becomes 
ineffective in trapping exhaust fumes. See Figure 8. 

Figure 8. Edwards forepump and attached oil mist filter showing the maximum oil level for efficient performance of the filter

Check the level and color of the oil in the forepump (also referred to as a backing pump, a 
roughing pump, or a rotary-vane pump) at least once a month. Check the oil level in the oil 
mist filter that is attached to the Edwards forepump on a daily basis.

To check the oil level in the forepump, look through the oil sight glass at one end of the 
forepump. The oil level should be between the upper and lower marks positioned next to the 
window. See Figure 9. The oil color should be a clear light yellow. 

220 V ac

EDWARDS

30

Oil Mist Filter EMF 20

EDWARDS

MAINS IN

PUMP OUT

MAINS ON/OFF

GAS IN
6 BARS MAX

MSQ Plus Mass Detector

Gas ballast knob
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Oil return tubing

To
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Checking the Oil Level in the Oil Mist Filter and the Forepump
Figure 9. End of Edwards forepump showing oil-level window

Perform maintenance as necessary:

• If the oil level is near or below the lower mark, add more oil, as described in the manual 
that comes with the Edwards forepump.

• If the oil has turned red in color or if the forepump has been in operation for more than 
3000 hours since the oil was replaced, replace the oil, as described in the manual that 
comes with the Edwards forepump.

To drain the oil from the oil mist filter and to purge the oil of volatile contaminants

1. If the LC pump is pumping solvent, turn the pump flow off.

2. Put the MSQ Plus Mass Detector in Off mode by doing one of the following:

• From the Status page of the Information view in the Xcalibur data system, right-click 
the MSQ Plus listing to display a shortcut menu, and choose Turn Device Off from 
the menu.

–or–

• Open the Per Method Parameters table in the Tune window. Take the system out of 
Operate mode by clicking the Operate On/Off toggle button. Then turn off the 
nitrogen gas by clicking the Nitrogen Gas On/Off toggle button.

3. Open the gas ballast valve on the Edwards forepump by turning it six rotations 
counterclockwise.

EDWARDS

E32M30

Oil mist filter

Edwards forepump

Oil level window
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Preparing the LC for Operation
4. Operate the Edwards forepump for approximately 15 minutes with the gas ballast valve 
open. This allows enough time to return the oil to the forepump and to remove volatile 
solvents such as water from the oil.

5. After you have ballasted the forepump to remove volatile solvents, close the gas ballast 
valve by turning the gas ballast knob clockwise until you feel resistance.

Preparing the LC for Operation
Before you tune your MSQ Plus Mass Detector or begin a sequence run, check the status of 
your LC system. Verify that the solvent bottles contain the appropriate solvents and that the 
solvent lines are free of air. If the modules of your liquid chromatograph are controlled from 
the Xcalibur data system, verify that they are communicating with the data system and are 
ready for operation.

If you have an Accela LC system, ensure that the wash bottle contains solvent and that the 
syringe of the Accela autosampler and the four solvent reservoir lines are free of air. If 
necessary, use the Flush command to remove air from the syringe and the tubing that 
connects the syringe to the wash bottle. If you are using an Accela pump, use a Purge 
command to remove air from the solvent reservoir lines or to draw fresh solvent through the 
lines. For more information on the Accela LC system, refer to the Accela Getting Started with 
Xcalibur 2.0 Guide or the Accela Xcalibur 2.1.x User Guide.

Note  Operating the forepump with the gas-ballast valve open increases the rate of oil 
loss from the pump. During normal operations, run the forepump with the gas ballast 
valve closed.

Note  If you are using a viscous wash solvent, such as a methanol/water mix, reduce the 
flush speed for the Accela autosampler from its default of 400 μL/s to 100 μL/s.
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4

Calibrating the MSQ Plus Mass Detector

The MSQ Plus Mass Detector software includes an automated wizard that provides three 
levels of calibration:

• Full-system autotune: This procedure is performed by a Thermo Fisher Scientific service 
engineer during the initial installation of the MSQ Plus Mass Detector. You do not need 
to repeat this procedure unless you perform maintenance on the inner components of the 
source block or reinstall or upgrade the Xcalibur software. 

• Mass-scale calibration: This procedure is a subset of the full-system autotune procedure. 
You should perform a mass-scale calibration if you notice a drift in the mass accuracy of 
your analyses or every 3 to 6 months as part of your routine maintenance schedule for the 
MSQ Plus Mass Detector.

• Detector gain calibration: This procedure resets the gain of the electron multiplier as it 
ages with use.

Before you perform a full-system autotune or a mass-scale calibration, prepare your MSQ Plus 
Mass Detector, as described in the first topic of this chapter.

Note  To perform any of these calibration procedures, you must connect an LC pump that 
is capable of delivering solvent at a flow rate of 200 μL/min to your MSQ Plus Mass 
Detector. Refer to the MSQ Plus Mass Detector Getting Connected Guide for instructions 
on connecting an LC system to your MSQ Plus Mass Detector.

Contents

• Preparing the MSQ Plus Mass Detector for Calibration

• Performing a Full-System Autotune

• Performing a Mass-Scale Calibration

• Performing a Detector Gain Calibration
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Preparing the MSQ Plus Mass Detector for Calibration
To perform a full-system autotune, mass-scale calibration, or detector gain calibration, you 
must set up the mass detector for ESI mode and ensure that the reference inlet reservoir 
contains a sufficient volume of factory-supplied calibrant.

To prepare the MSQ Plus Mass Detector for calibration, follow these procedures:

1. Verifying that the MSQ Plus Mass Detector is Set Up for ESI Mode

2. Setting Up the LC System

3. Checking the Solvent Levels in the Reference Inlet System

4. Setting the Gas Flows and Probe Heater Temperature

5. Baking Out the Probe (Optional)

6. Flushing Air from the Lines of the Reference Inlet System

7. Viewing the Mass Spectrum of the Calibrant Solution (Optional)

Verifying that the MSQ Plus Mass Detector is Set Up for ESI Mode

To perform a full-system autotune or a mass-scale calibration, the MSQ Plus Mass Detector 
must be set up in ESI mode. Figure 10 shows an MSQ Plus Mass Detector set up for 
operation in ESI mode.

Figure 10. MSQ Plus Mass Detector set up for operation in the ESI mode 

To verify that the mass detector is set up for ESI mode

1. Open the front door of the mass detector by depressing the latch on the left side of the 
mass detector.
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2. Ensure that the ESI probe is connected and that the corona pin knob is in the vertical 
position.

For instructions on switching your mass detector to ESI mode, refer to the MSQ Plus 
Mass Detector Hardware Manual.

Setting Up the LC System

To perform a full-system autotune or a mass-scale calibration, connect an LC pump to your 
MSQ Plus Mass Detector. The LC pump must be set to deliver 50:50 acetonitrile/water at a 
flow rate of 200 μL/min. If your LC system is set up for chromatography, remove the LC 
column and replace it with a backpressure regulator.

To set up the LC pump

1. For Xcalibur 2.0.7, choose Start > Programs > Xcalibur > Instrument Configuration. 
On the Roadmap view of the Xcalibur Home Page, click the Instrument Setup icon.

–or–

For Xcalibur 2.1.x, choose Start > Programs > Thermo Xcalibur > Xcalibur to start 
Xcalibur. On the Roadmap view, click the Instrument Setup icon.

The Instrument Setup window appears with icons for all of the currently configured 
devices for your LC/MS instrument displayed down the left side of the window. 
Instrument Setup pages and dialog boxes for the selected device are displayed on the right 
side of the view. You can access additional dialog boxes for the device by clicking the 
device listing in the menu bar.

2. Open the Direct Control dialog box for your LC pump.

3. Leave the Direct Control dialog box open, and adjust the size of the Instrument Setup 
window to half the size of your view screen.

Checking the Solvent Levels in the Reference Inlet System

The reference inlet system includes a reference inlet reservoir bottle and a waste bottle. To 
perform a full-system autotune or a mass-scale calibration, the reference inlet reservoir bottle 
must contain a sufficient level of calibrant solution (>50 mL), and the waste bottle must not 
be full. 

Note  When the front door is open, do not attempt to insert a screwdriver or other 
device into the safety interlock switch, because a severe shock can result.
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The factory-supplied calibrant (compatible with the Thermo MSQ 2.0 software) contains 
1.3 mM sodium iodide (NaI), 0.05 M potassium iodide (KI), and 0.02 mM cesium iodide 
(CsI) in 50:50 isopropanol/water. A 250 mL bottle of calibrant is shipped with the MSQ Plus 
Mass Detector. You can purchase refill bottles from Thermo Fisher Scientific or prepare your 
own calibration solution. Refer to “Calibrant Solution” on page 104 for a suggested procedure 
for preparing the calibration solution.

To check the solvent levels in the reservoir bottles

1. Open the front door of the MSQ Plus Mass Detector by depressing the door latch on the 
left side of the mass detector as you pull forward on the door.

2. Check the level of the calibrant solution in the reference inlet reservoir, which is the bottle 
on the right. See Figure .

Figure 11. View of reference inlet reservoir bottle and waste bottle 

3. If the volume of calibrant solution is less than 50 mL, refill the bottle. After you refill the 
bottle, ensure that the bottle cap is closed tightly. 

4. Check the level of waste solution in the waste bottle, the bottle on the left (see Figure 11). 

5. If the waste bottle is full of solvent, empty it.

Connected to
port 6 of valve

Connected to 
port 5 of valve

Nitrogen 
pressurization line

BOTTLE CAP 
MUST BE 
CLOSED 
TIGHTLY

ClipClip
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Setting the Gas Flows and Probe Heater Temperature

Turn on the nitrogen gas and the probe heater.

To turn on the nitrogen gas and the probe heater

1. Verify that the nitrogen regulator is set to 5.2 bar (75 psi). See Figure 5 on page 16.

2. Right-click the Server icon in the Windows taskbar, and choose Manual Tune, as shown 
in Figure 12.

Figure 12. Server shortcut menu

3. If it is not already open, open the Per Method Parameters table of the Tune window, 
shown in Figure 13, by clicking the Show Per Method Parameters bar at the top right of 
the Tune window.

Figure 13. View of Per Method Parameters table with Operate on and Nitrogen Gas on 

4. Click the Nitrogen Gas On/Off toggle button to turn the nitrogen flow on. 

The toggle button turns green, and the text changes to On. Within a few seconds, you 
hear the flow of the nitrogen gas. 

5. Click the Operate toggle button to place the system in the operate mode.

6. Click the Probe Temperature Setpoint box. Type 350 in the box, and then press 
ENTER.

The probe temperature rises to 350 °C.

If the MSQ Plus Mass Detector has not been used recently or was last used in APCI mode, go 
to the next topic, “Baking Out the Probe (Optional)” on page 28. If you do not need to bake 
out the probe, go to “Flushing Air from the Lines of the Reference Inlet System” on page 28.

Note  The gas flows are preset and do not require adjustment. 
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Baking Out the Probe (Optional)

If the MSQ Plus Mass Detector has not been used recently or was last used in APCI mode, 
bake out the probe before starting the LC flow. To do this, set the probe temperature to 
550 °C and leave the nitrogen gas flowing for approximately 5 min. Then reset the probe 
temperature to 350 °C. 

Flushing Air from the Lines of the Reference Inlet System

Before you start the Instrument Tune and Calibration wizard, flush the air out of the tubing 
that connects the reference inlet reservoir to the injection valve of the mass detector. Flushing 
air out of the lines helps to ensure a successful calibration.

To flush air out of the reference inlet system

1. Display the advanced parameters in the Per Method Parameters table:

a. From the menu bar of the Manual Tune window, choose View > Options, as shown 
in Figure 14, to open the Tune Options dialog box.

Figure 14. View menu

b. Select the Show Advanced Parameters check box (see Figure 15). Then click OK to 
exit the dialog box.

CAUTION  Ensure that switching Operate to On also turns the Nitrogen Gas to On.  High 
probe temperature in the absence of nitrogen gas could damage the probe heater.
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Figure 15. Tune Options dialog box 

2. In the Sequence Control area of the Per Method Parameters table, click the Inject from 
Ref. Inlet toggle button. See Figure 16.

Figure 16. Per Method Parameters table with advanced parameters

The MSQ Plus Mass Detector draws calibrant from the reference inlet reservoir bottle 
through the tubing and into 500 μL sample loop for 35 seconds.

Inject from Ref. Inlet 
toggle button
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The MSQ Plus Mass Detector is ready for calibration. To view a mass spectrum of the 
calibrant solution before you calibrate your mass detector, go to the next topic,“Viewing the 
Mass Spectrum of the Calibrant Solution (Optional).” 

Viewing the Mass Spectrum of the Calibrant Solution (Optional)

You can optionally view the mass spectrum produced by infusing the calibrant solution.

To view the mass spectrum of the calibrant

1. Open the Advanced Options version of the Per Method Parameters table. For instructions 
on displaying the Advanced Options parameters, see “Flushing Air from the Lines of the 
Reference Inlet System” on page 28.

2. If the nitrogen gas is off, turn it on by clicking the Nitrogen Gas On/Off toggle button.

3. If the MSQ Plus Mass Detector is not in Operate mode, start its operation by clicking the 
Operate toggle button.

4. In the Per Method Parameters table, set the following parameters:

• If the probe temperature is not already set to 350 °C, click the Probe Temperature 
Setpoint box, type 350, and then press ENTER.

• If the needle voltage is not already set to 3 kV, click the Needle (kV) Setpoint box, 
type 3, and then press ENTER.

5. In the Full Scan Events table, shown in Figure 17, set the scan parameters so that you can 
view the entire mass spectrum of the calibrant solution:

• Click the Mass box and type 1000.

• Click the Span box and type 1997.

• Click the Scan Time box and type 2.

These settings let you to view the entire mass spectrum of the calibrant solution. The 
characteristic peaks in the mass spectrum of the calibrant solution for the MSQ Plus Mass 
Detector are listed in Table 3.

Figure 17. Full Scan Events table 

Table 3. Characteristic peaks in the mass spectrum of the calibrant solution (Sheet 1 of 2)

Peak # Mass-to-charge ratio Peak # Mass-to-charge ratio

1 22.99 8 1072.25

2 38.96 9 1222.14

3 83.05 10 1372.04
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6. Turn on the solvent flow from the LC pump. Ensure that the pump is set to deliver 50:50 
acetonitrile/water at a flow rate of 200 μL/min.

7. In the Sequence Control area of the Per Method Parameters table, click the Inject from 
Ref. Inlet toggle button, shown in Figure 16. 

The MSQ Plus Mass Detector draws calibrant from the reference inlet reservoir bottle, 
through the tubing, and into the 500 μL sample loop for 35 seconds. At a flow rate of 
200 μL/min, it takes 2.5 minutes to empty the sample loop. During this time, you can 
view a mass spectrum of the calibrant solution in the Peak Display area of the 
Tune window, as shown in Figure 18.

Figure 18. Mass spectrum of calibrant solution with centroid peak format

Performing a Full-System Autotune
After you move your MSQ Plus Mass Detector to a new environment, perform maintenance 
on the inner components of the source block, or reinstall or upgrade the Xcalibur software, 
you must perform a full-system autotune. 

To perform a full-system autotune

1. Ensure that you have prepared your mass detector for calibration, as described in the 
preceding procedure, “Preparing the MSQ Plus Mass Detector for Calibration.” 

4 132.91 11 1521.93

5 172.88 12 1671.83

6 472.67 13 1821.72

7 622.57 14 1971.61

Table 3. Characteristic peaks in the mass spectrum of the calibrant solution (Sheet 2 of 2)

Peak # Mass-to-charge ratio Peak # Mass-to-charge ratio

Note  Always perform a full-system autotune in ESI mode.
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2. Set the LC pump to deliver a solvent composition of 50:50 acetonitrile/water at a flow 
rate of 0.2 mL/min.

3. Right-click the Server icon to display a shortcut menu, and then choose Instrument 
Tune and Calibration, as shown in Figure 19.

Figure 19. Server shortcut menu

The Instrument Tuning and Calibration wizard shown in Figure 20 appears.

Figure 20. Instrument Tuning and Calibration wizard

4. Select the Full System Autotune option, and then click Next. 

A series of messages inform you of the progress of the tuning and the calibration 
procedure. If the tuning or calibration procedure fails, an error message appears.

5. To accept the results of the autotune, click Finish. 

The software replaces the current tune and calibration files with the ones generated by the 
autotune.

6. Click Print Report to print the calibration report. An autotune report for a full-system 
autotune is shown in Figure 21.
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Figure 21. Autotune report for a full-system autotune 

Reviewed By: Date: 

AutoTune Status:  Pass 

Tune Parameters 
Probe Temperature ( C) 
Needle Voltage (kV) 
Detector Voltage (V) 
RF Lens Bias (V) 
Ion Energy (V) 
Ion Energy Ramp (mV/amu) 
Low Mass Resolution 
High Mass Resolution 
Cone (V) 
RF Frequency 
Linearity Adjust 
Low Mass Res Mid Point 
High Mass Res Mid Point 
 

 
 

Set Point 
349 
3.0 

988 
0.5 
0.5 
0.3 

12.7 
12.5 

75 
236755120 

-0.05 
55 

14147 

Actual 
342 
3.0 

1023 
0.5 
n/a 
n/a 
n/a 
n/a 
74 
n/a 
n/a 
n/a 
n/a 

Mass Calibration Results 
Calibration Type 
Missed Ref Peaks 
Standard Deviation[max 0.2] 
R.M.S. Error 
Max Residual Error(m/z)[max 0.3] 
Calibrated Range Min(m/z) 
Calibrated Range Max(m/z) 

Fast 
Autotune 

0 
0.0509 
0.0520 
.0.1328 

22.9898 
1971.6149 

Slow 
Autotune 

0 
0.0436 
0.0446 
.00778 

22.9898 
1971.6149 

Ref-Peak 
22.99 
38.96 
83.05 

132.91 
172.88 
472.67 
622.57 
772.46 
922.36 

1072.25 
1222.14 
1372.04 
1521.93 
1671.83 
1821.72 
1971.61 

Search- 
18.99 
37.03 
81.00 

130.93 
168.88 
470.71 
620.52 
770.38 
920.30 

1070.25 
1220.18 
1370.08 
1519.99 
1669.88 
1819.77 
1969.64 

From-To 
26.99 
41.03 
85.00 

134.93 
176.88 
474.74 
624.54 
774.44 
924.36 

1074.27 
1224.18 
1374.09 
1523.99 
1673.86 
1823.73 
1973.69 

Real-Peak 
23.05 
38.92 
83.07 

132.90 
172.92 
472.63 
622.49 
772.41 
922.36 

1072.28 
1222.18 
1372.09 
1521.99 
1671.88 
1821.75 
1971.60 

 

Mass-Shift 
0.06 

-0.05 
0.03 
0.00 
0.04 

-0.05 
-0.08 
-0.05 
0.00 
0.04 
0.04 
0.05 
0.05 
0.05 
0.03 

-0.02 
 

Ref-Peak 
22.99 
38.96 
83.05 

132.91 
172.88 
472.67 
622.57 
772.46 
922.36 

1072.25 
1222.14 
1372.04 
1521.93 
1671.83 
1821.72 
1971.61 

Search- 
18.99 
37.04 
80.91 

130.93 
170.90 
470.66 
620.54 
770.37 
920.28 

1070.24 
1220.15 
1370.01 
1519.96 
1669.86 
1819.76 
1969.61 

From-To 
26.99 
41.04 
84.91 

134.93 
174.90 
474.66 
624.54 
774.37 
924.28 

1074.24 
1224.15 
1374.01 
1523.96 
1673.86 
1823.76 
1973.61 

Real-Peak 
23.06 
38.83 
83.07 

132.92 
172.87 
472.65 
622.47 
772.39 
922.35 

1072.26 
1222.12 
1372.06 
1521.97 
1671.87 
1821.71 
1971.60 

 

Mass-Shift 
0.07 

-0.13 
0.02 
0.02 

-0.01 
-0.03 
-0.10 
0.01 

-0.07 
-0.01 
0.02 
0.03 
0.03 
0.04 

-0.01 
-0.01 Diagnostic Messages 

No Messages. 

Fast Calibration 1000.00 Da/S 
0.13 

0.00 

-0.13 
22.99 1971.61 

Fast Mass Shift 1000.00 Da/S 

Slow Calibration 250.00 Da/S 

Slow Mass Shift 250.00 Da/S 

(Peak widths are measured at 10% height) 

AutoTune Report 
Laboratory: 
Instrument ID: 
Serial Number: 

Product Evaluation
MSQ Plus
999999

Filename: 
Tune Date: 
Report Date: 

Calibration.msqreport 
10/27/2004 8:31:28 AM 
10/27/2004 8:45:58 AM 

472.67 

1971.61 

0.53 

0.00 

-0.53 

0.08 

0.00 

-0.08 

6.32 

0.00 

-6.32 
172.88 1971.61 

171 175 1070 1074 1970 1974 
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Performing a Mass-Scale Calibration
Performing a Mass-Scale Calibration
Perform a mass-scale calibration every three to six months as part of a standard maintenance 
program or if you notice a drift in the mass accuracy of the mass detector.

Before you perform a mass-scale calibration, prepare your system, as described in “Preparing 
the MSQ Plus Mass Detector for Calibration” on page 24.

To perform a mass-scale calibration

1. Set the LC pump to deliver a solvent composition of 50:50 acetonitrile/water at a flow 
rate of 0.2 mL/min.

2. Right-click the Server icon to display the shortcut menu shown in Figure 19 on page 32, 
and choose Instrument Tune and Calibration to open the Instrument Tuning and 
Calibration wizard shown in Figure 20 on page 32 .

3. Select the Mass Scale Calibration option, and click Next.

A series of messages inform you of the progress of the calibration. If the calibration fails, 
an error message appears.

4. To accept the results of the calibration, click Finish.

The current calibration file is replaced with the one generated by the mass-scale 
calibration procedure.

5. Click Print Report to print the calibration report.

Performing a Detector Gain Calibration

As ions exit the mass analyzer, the gain of an electron multiplier is the number of electrons 
created in each ion event. The gain depends on the age of the electron multiplier and the 
velocity of the impinging electron which, in turn, depends on the voltage applied between the 
input and output of the multiplier. 

At a given point in the lifetime of an electron multiplier, a single ion event has a given gain. As 
the electron multiplier ages, its gain decreases, because it does not release as many secondary 
electrons from a given ion event. To maintain a gain of approximately 4.5 × 105, the voltage 
applied across the input and output of the multiplier must be increased. 

Note  Always perform the mass-scale calibration procedure in ESI mode.

Note  Detector gain calibration is only available in the engineering version of the Tune 
application.
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Performing a Detector Gain Calibration
The change in gain over time is directly related to the number of ions that impinge the 
detection system and the voltage at which the electron multiplier is operated. Under normal 
operating conditions, this decrease in detector gain, which translates as a loss in sensitivity, 
necessitates a detector gain calibration every three to four months. If the detector is subject to 
heavy use, you might need to perform a detector gain calibration every two months. 

You can automatically calibrate the gain of the electron multiplier by running the detector 
gain calibration routine, as described in the following procedure.   

To calibrate the gain of the electron multiplier

1. Ensure that you have prepared your MSQ Plus Mass Detector for calibration, as described 
in the “Preparing the MSQ Plus Mass Detector for Calibration” on page 24. 

2. In the area of the Tune window, do the following:

• In the Peak Format list, select Profile.

• In the Mass box, type 300 or an equivalent value for the center mass corresponding 
to a relatively low intensity peak <104 cps.

3. Right-click the Status Indicator and choose Instrument Tune and Calibration to open 
the Instrument Tuning and Calibration wizard. See Figure 19 on page 32.

4. Select the Detector Gain Calibration option, and then click Next. 

The Detector Gain Calibration confirmation page appears.

5. Ensure that you set up the LC/MS system, as described in step 1 and step 2 of this 
procedure, and click Next to start the automated calibration process. 

During the automated calibration process, the software performs the steps listed in 
Table 4.

IMPORTANT  The gain routine strives to achieve conditions where it is receiving 
single ion counts. Therefore, it is important to scan a mass region where only 
low-level chemical noise is present. Avoid placing the center mass at a high-intensity 
peak. Doing so will make it harder for the software to control the ion flow rate and 
cause the tuning process to fail.

Table 4. Steps in the automated calibration process (Sheet 1 of 2)

Automated Detector Gain Routine

Step 1 Turns off the ion flow and captures the electronic noise.

Step 2 Determines the peak-to-peak difference between the minimum and 
maximum values for the absolute analog to digital converter noise.

Step 3 Turns the ion flow on.

Step 4 Starting from 700 V, increases the voltage in 50 V intervals until the 
peak-to-peak signal intensity is more than 10 times the noise signal.
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4 Calibrating the MSQ Plus Mass Detector
Performing a Detector Gain Calibration
Once the tune process successfully finishes, the equation of the calibration curve appears, 
and the Finish button becomes available as shown in Figure 6.

Figure 22. Instrument Tuning and Calibration wizard showing the calibration curve produced 
by the tune process

The equation of the calibration curve produced by the tune event shown in Figure 6 is as 
follows:

6. If the calibration has not finished within 12 minutes, click Cancel, and verify that the 
value in the Mass box corresponds to a low-intensity region. 

7. Click Finish.

Step 5 Adjusts the ion flow rate to approximately 1000 counts per second. 
Measures the multiplier output response to each ion event to determine 
gain at this multiplier voltage.

Step 6 Raises the multiplier voltage by 50 V and repeats step 5. This process is 
repeated several times.

Step 7 Creates a calibration curve over the measured multiplier voltage range and 
determines the multiplier voltage required to produce a gain of 450,000.

Table 4. Steps in the automated calibration process (Sheet 2 of 2)

Automated Detector Gain Routine

Voltage 438– 149 450 000,( )ln×+=

Voltage 1506=
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 4 Calibrating the MSQ Plus Mass Detector
Performing a Detector Gain Calibration
The Confirm Set Electron Multiplier Voltage dialog box appears, as shown in Figure 23.

Figure 23. Confirm Set Electron Multiplier Voltage dialog box

Figure 24. Contents of Xcalibur\Cali\Report folder for 2.0.7

WARNING  To complete the detector gain calibration, do one of the following:

• To apply the new voltage setting to the electron multiplier, click OK. The new 
voltage setting is stored in the registry.

–or–

• To keep the current detector voltage, click Cancel.

After you complete the detector gain calibration, the Tune page appears. As Figure 24 
and Figure 25 show, the software automatically stores tune reports in the following 
directories.

For Xcalibur 2.1.x:

Drive:\Thermo\Instruments\MSQ\Cali\report

For Xcalibur 2.0.7:

Drive:\Xcalibur\Cali\report
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Figure 25. Contents of Thermo\Instruments\MSQ\Cali\Report for 2.1
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5

Manual Tuning in ESI Mode

Before you create an instrument method, you must optimize the acquisition parameters of the 
MSQ Plus Mass Detector for your compound of interest. The process of optimizing the 
acquisition parameters of the MSQ Plus Mass Detector for a particular compound or family 
of compounds is referred to as manual tuning and is performed from the Tune window. 

This chapter describes how to optimize the tune parameters for a compound of interest. 
Perform the procedures that are provided in this chapter in the following order. If your LC 
devices are controlled by the Xcalibur data system, begin with “Setting Up the LC for Direct 
Control” on page 40. Otherwise, begin with “Selecting Your Tune Options” on page 41.

In the ESI mode, you optimize the parameters listed in Table 5. 

Contents

• Setting Up the LC for Direct Control

• Selecting Your Tune Options

• Acquiring and Viewing a Raw Data File

Table 5. Tune controls in the ESI mode

Tune window control Description Typical value

Needle (kV) Voltage that is placed on 
the stainless steel insert 
capillary.

The optimal value depends on the structure of your 
analyte and the flow rate of the mobile phase.

Typical values range from 3 kV to 5 kV.

Probe Temperature Temperature setting of the 
probe heater. 

The optimal value depends on the flow rate of the mobile 
phase. In general, you must increase the probe 
temperature as you increase the flow rate of the mobile 
phase. Refer to Table 1 on page 7.

Cone (V) Voltage that is placed on 
the source block and the 
entrance cone.

The optimal value depends on the structure of your 
analyte.

Increasing the cone voltage can decrease adduct 
formation and give rise to fragmentation, which provides 
structural information about your analyte. 

Typical cone voltage values range from 75 V to 150 V.
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5 Manual Tuning in ESI Mode
Setting Up the LC for Direct Control
If you are a novice user, you might want to experiment with the manual tuning features of the 
MSQ Plus Mass Detector by starting with one of the tune files included with the data system. 
For ESI mode, start with the esipos.tune file and inject the sensitivity test compound that is 
shipped with your mass detector. For most analytes, the RF lens bias and ion energy 
parameters are optimized at 1.0 V and 0.8 V, respectively. The suggested sensitivity test 
solution for the positive-ion polarity mode is a 5 pg/μL solution of erythromycin. The 
preparation of these test solutions is described in “Sample Formulations” on page 99.

If you are an advanced user, refer to the Help for information on the advanced options in the 
Tune window.

Setting Up the LC for Direct Control
During the manual tuning process, you make several injections. If your LC system is 
controlled from the Xcalibur data system, open the Instrument Setup window before you 
open the Tune window so that you can access the Direct Control dialog boxes for the LC 
pump and the autosampler.

To open the Instrument Setup window and adjust its size as follows

1. For Xcalibur 2.0.7, choose Start > Programs > Xcalibur > Instrument Configuration. 
On the Roadmap view of the Xcalibur Home Page, click the Instrument Setup icon.

–or–

For Xcalibur 2.1.x, choose Start > Programs > Thermo Xcalibur > Xcalibur to start 
Xcalibur. On the Roadmap view, click the Instrument Setup icon.

The Xcalibur data system displays the Instrument Setup window with icons for all of the 
currently configured devices for your LC/MS instrument arranged down the left side of 
the view. Instrument Setup pages and dialog boxes for the selected device are displayed on 
the right side of the view. You can access additional dialog boxes for the device by clicking 
the device listing in the menu bar.

2. Leave the Instrument Setup window open, but adjust its size to half the size of your view 
screen or minimize it.

When you acquire data in the Tune window, use the Direct Control dialog box for the LC 
pump to start the mobile phase flow. You use the Direct Control dialog box for the 
autosampler to inject your analyte.

Note  To enter an optimal needle voltage for your application into an instrument method, 
you must empirically determine the optimal needle voltage from the Tune window, save 
the value in a tune file, and then import the tune file into an instrument method.
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Selecting Your Tune Options
The display in the Tune window contains a mass spectrum corresponding to each row in the 
Scan Events table at the bottom of the window. As you optimize the MS parameters for a 
particular compound, the mass spectra displayed in the Tune window will change. To record 
the changes in the mass spectra, collect the data in a raw data (.raw) file. If you are a novice 
user, you might want to experiment with the tune parameters for your compound by starting 
with one of the tune files that is shipped with the data system. 

The following procedure describes how to create a file name for the raw (.raw) data file that is 
created by the data system after you start data acquisition from the Tune window. It also 
explains how to select a stored tune (.tune) file from the Tune window that you use as a 
template.

To select your tune options

1. Right-click the Server icon to display a shortcut menu, and choose Manual Tune to open 
the Tune window.

2. Choose View > Options to open the Tune Options dialog box, shown in Figure 26.

Figure 26. Tune Options dialog box

Raw data file 
button

Tune file button
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Selecting Your Tune Options
3. Enter an acquisition file name for the raw data file that the data system creates after you 
start data acquisition in the Tune window:

a. Click the button to the right of the Acquisition Filename box to open the Select Tune 
Raw File Name dialog box, shown in Figure 27.

Figure 27. Select Tune Raw File Name dialog box

b. Browse to the directory where you want to store your raw data. Then type an 
appropriate file name in the Filename box. 

c. Click Open to create the file name for the raw file, and close the Select Tune Raw File 
Name dialog box.

4. Open and download the parameters from a stored tune file:

a. Click the button to the right of the Tune Filename box to open the Select Tune 
Parameter File Name dialog box, shown in Figure 28.

Note  The Xcalibur data system does not check your directory for the reserved file 
name. If you reuse a file name, the data system appends the date and time at 
which you start data acquisition to the file name.
42 MSQ Plus Mass Detector Getting Started Guide Thermo Scientific



 5 Manual Tuning in ESI Mode
Selecting Your Tune Options
Figure 28. Select Tune Parameter File Name dialog box 

b. Select an appropriate tune file or create a new tune file. 

c. If you are a novice user and you want to experiment with the tune parameters, open 
the esipos.tune file, as shown in Figure 29. 

Figure 29. Displaying the tune parameters contained in the esipos.tune file in the Tune window

d. Click Open to download the tune parameters, and close the Select Tune Parameter 
File Name dialog box.

ESI mode

Positive 
ion polarity 
mode (+ve)
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Acquiring and Viewing a Raw Data File
Follow the steps in this section to acquire and view a raw data file.

To acquire and view a raw data file

1. Start the mass detector:

a. If the Per Method Parameters table is not open, open it by clicking the Show Per 
Method Parameters bar.

b. Turn on the nitrogen flow to the API probe by clicking the Nitrogen Gas toggle 
button.

c. Start the operation of the MSQ Plus Mass Detector by clicking the Operate toggle 
button.

2. Start the LC flow. Use the same mobile phase conditions that you plan to use when you 
create your acquisition method.

3. Start the acquisition of data by clicking the Start Acquiring icon, shown in Figure 30, in 
the Tune window toolbar.

Figure 30. Start Acquiring and Stop Acquiring icons in the Tune window toolbar

4. Double-click the Qual Browser icon, , to open the Qual Browser window, shown in 
Figure 31, from the Roadmap view.

Figure 31. Qual Browser window

5. Open your raw data file:

a. From the Qual Browser menu bar, choose File > Open to open the Open Raw File 
dialog box. 

b. Select the raw data file that you are acquiring. 

Stop Acquiring button

Start Acquiring button
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c. Click Open to open the file in the Qual Browser window, and close the Open Raw 
File dialog box, shown in Figure 32.

Figure 32. Open Raw File dialog box

6. Inject your sample. If your autosampler is controlled by the Xcalibur data system, open its 
Direct Control dialog box from the Instrument Setup window. Enter an appropriate 
injection volume and vial location. Click Apply.

7. From the Qual Browser window, observe the chromatogram. To view the data as it is 
acquired, periodically press F5. 

8. From the Tune window, change the parameters for the needle voltage, probe temperature, 
and cone voltage.

You cannot alter the cone voltage while data acquisition is in progress.

Note  When you create an instrument method, you import the tune file that contains 
the optimized needle voltage for your application. You must manually enter the 
optimal probe temperature and cone voltage into the instrument method.
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9. Repeat step 6 through step 8 until you finish optimizing the parameters for your 
compound. 

10. After you finish optimizing the parameters for your compound, stop the data acquisition 
by clicking the Stop Acquiring icon shown in Figure 30 in the Tune window toolbar.

11. Save your tune file:

a. Choose File > Save As from the Tune window menu bar to open the Save Tune 
Parameters dialog box, shown in Figure 33.

Figure 33. Save Tune Parameters dialog box

b. Type an appropriate name in the File name box.

c. Click Save to save the tune file with the optimized MS parameters for your 
compound of interest.
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6

Manual Tuning in the APCI Mode

Before you create an instrument method, you must optimize the acquisition parameters of the 
MSQ Plus Mass Detector for your compound of interest. The process of optimizing the 
acquisition parameters of the mass detector for a particular compound or family of 
compounds is referred to as manual tuning and is performed from the Tune window. 

This chapter describes how to optimize the tune parameters for a compound of interest. 
Perform the procedures that are provided in this chapter in the following order. If your LC 
devices are controlled by the Xcalibur data system, begin with “Opening the Instrument 
Setup Window” on page 49. Otherwise begin with “Selecting Your Tune Options” on 
page 50. 

In the APCI mode, you optimize the parameters listed in Table 7.

Contents

• Opening the Instrument Setup Window

• Selecting Your Tune Options

• Acquiring and Viewing a Raw Data File

Table 6. Tune controls in the ESI mode (Sheet 1 of 2)

Tune window control Description Typical value

Corona (mA) This is the current on the 
corona pin.

The optimal value depends on the structure of your 
analyte.

Although allowable values range from 2 to 50 uA, use the 
lowest value that gives adequate sensitivity. Corona 
readbacks might vary, depending on the eluent 
composition and conductivity. Typical values range from 
3 to 5 kV.
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6 Manual Tuning in the APCI Mode
The MSQ Plus Mass Detector is shipped with the ESI probe installed. Install the APCI probe 
and the APCI corona pin before you begin the procedures that are provided in this chapter. 
Figure 34 shows the APCI setup for the MSQ Plus Mass Detector. For instructions on 
switching the probes, refer to the MSQ Plus Mass Detector Hardware Manual.

Figure 34. MSQ Plus Mass Detector setup for the APCI mode 

Probe Temperature This is the temperature 
setting of the probe heater. 

The optimal value depends on the flow rate of the mobile 
phase. In general, you need to increase the probe 
temperature as you increase the flow rate of the mobile 
phase. See Table 1 on page 7.

Cone (V) This is the voltage that is 
placed on the source block 
and the entrance cone.

The optimal value depends on the structure of your 
analyte.

Increasing the cone voltage can decrease adduct 
formation, common to ESI, and give rise to 
fragmentation, which provides structural information 
about your analyte. Increasing the cone voltage to reduce 
adduct formation is useful in the presence of interfering 
compounds. 

Typical cone voltage values range from 75 to 150 V.

Table 6. Tune controls in the ESI mode (Sheet 2 of 2)

Tune window control Description Typical value

Note  To enter the optimal corona current for your sample into an instrument method, 
you must determine its value from the Tune window, save the value in a tune file, and 
then import the Tune file into an instrument method.
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The corona pin position might be dropped by as much as 1 to 2 centimeters if it improves the 
signal.

If you are a novice user, you might want to experiment with the manual tuning features of the 
MSQ Plus Mass Detector by starting with one of the tune files included with the data system. 
For the APCI mode, start with the apcipos.tune file and inject the sensitivity test compound 
that is shipped with your mass detector. For most analytes, the RF lens bias and ion energy 
parameters are optimized at 1.0 V and 0.8 V, respectively. The suggested sensitivity test 
solution for the positive ion polarity mode is a 5 pg/μL solution of erythromycin. The 
preparation of this test solution is described in “Sample Formulations” on page 99. If you are 
an advanced user, refer to the Help for information on the advanced options in the Tune 
window.

Opening the Instrument Setup Window
If your LC system is controlled from the Xcalibur data system, open the Instrument Setup 
window before you open the Tune window.

To open the Instrument Setup window 

1. For Xcalibur 2.0.7, choose Start > Programs > Xcalibur > Instrument Configuration. 
On the Roadmap view of the Xcalibur Home Page, click the Instrument Setup icon.

–or–

For Xcalibur 2.1.x, choose Start > Programs > Thermo Xcalibur > Xcalibur to start 
Xcalibur. On the Roadmap view, click the Instrument Setup icon.

Xcalibur displays the Instrument Setup window with icons for all of the currently 
configured devices for your LC/MS instrument arranged down the left side of the view. 
Instrument Setup pages and dialog boxes for the selected device are displayed on the right 
side of the view. You can access additional dialog boxes for the device by clicking the 
device listing in the menu bar.

2. Leave the Instrument Setup window open, but adjust its size to half the size of your view 
screen or minimize it.

When you acquire data in the Tune window, use the Direct Control dialog box for the LC 
pump to start the mobile phase flow and the Direct Control dialog box for the 
autosampler to inject your analyte.
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Selecting Your Tune Options
The display section of the Tune window contains a mass spectrum for each row in the 
Scan Events table at the bottom of the window. As you optimize the MS parameters for 
particular compound, the intensities of the mass spectra displayed in the Tune window will 
change. To record the changes in the mass spectra, collect the data in a raw data (.raw) file. If 
you are a novice user, you might want to experiment with the tune parameters for your 
compound by starting with one of the tune files that is shipped with the data system.

The following procedure describes how to create a file name for the raw (.raw) data file that is 
created by the data system after you start data acquisition from the Tune window. It also 
explains how to select a stored tune (.tune) file from the Tune window that you use as a 
template.

To select your tune options 

1. Right-click the Server icon to display its shortcut menu, and choose Manual Tune to 
open the Tune window.

2. Choose View > Options to open the Tune Options dialog box, shown in Figure 35.

Figure 35. Tune Options dialog box
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3. Enter an acquisition file name for the raw data file that will be created by the data system 
after you start data acquisition in the Tune window:

a. Click the button to the right of the Acquisition File Name box to open the 
Select Tune Raw File Name dialog box, shown in Figure 36. 

Figure 36. Select Tune Raw File Name dialog box

b. Browse to the directory where you want to store your raw data. Then type an 
appropriate file name into the File Name box. 

c. Click Open to create the file, and close the Select Tune Raw File Name dialog box.

4. Open and download the parameters from a stored tune file:

a. Click the button to the right of the Tune File Name box to open the Select Tune 
Parameter File Name dialog box, shown in Figure 37. 
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Figure 37. Select Tune Parameter File Name dialog box

b. Select an appropriate tune file or create a new tune file. 

c. If you are a novice user and you want to experiment with the tune parameters, open 
the apcipos.tune file, as shown in Figure 38. For most analytes, the RF lens bias and 
ion energy parameters are optimized at 1.0 V and 0.8 V, respectively.
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Figure 38. Displaying the tune parameters from the apcipos.tune file in the Tune window

d. Click Open to download the tune parameters and close the dialog box.

Acquiring and Viewing a Raw Data File
You can acquire a raw data file as you adjust the tune parameters for your compound of 
interest.

To acquire a raw data file as you adjust the tune parameters

1. Start the mass detector:

a. If the Per Method Parameters table is not open (see Figure 13 on page 27), open it by 
clicking the Show Per Method Parameters bar.

b. Turn on the nitrogen flow to the API probe by clicking the Nitrogen Gas toggle 
button.

c. Start the operation of the MSQ Plus Mass Detector by clicking the Operate toggle 
button.

2. Start the LC flow. Use the same mobile phase conditions that you plan to use when you 
create your acquisition method.

APCI mode

Positive 
ion polarity 
mode (+ve)
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3. Start the acquisition of data by clicking the Start Acquiring icon, shown in Figure 39, in 
the Tune window toolbar.

Figure 39. Start Acquiring and Stop Acquiring icons in the Tune window toolbar

4. Double-click the Qual Browser icon, , to Open the Qual Browser window, shown in 
Figure 31 on page 44, from the Roadmap view. 

5. From the Qual Browser menu bar, choose File > Open to open the Open Raw File dialog 
box. Select the raw data file that you are acquiring. Then, click Open to open the file in 
the Qual Browser window.

6. Inject your sample. If your autosampler is controlled by the Xcalibur data system, open its 
Direct Control dialog box and select an appropriate injection volume and vial location.

7. Observe the chromatogram in Qual Browser. To view the data as it is acquired, 
periodically press F5. 

8. Change the parameters for the corona current, probe temperature, and cone voltage in the 
Tune window.

You cannot alter cone voltage while data acquisition is in progress.

9. Repeat step 6 to step 8 until you finish optimizing the parameters for your compound. 

10. After you finish optimizing the parameters for your compound, stop the data acquisition 
by clicking the Stop Acquiring icon, shown in Figure 39, in the Tune window toolbar.

11. Save your tune file:

a. Choose File > Save As from the Tune window menu bar to open the Save Tune 
Parameters dialog box, shown in Figure 40.

Stop Acquiring button

Start Acquiring button

Note  When you create an instrument method, you import the tune file that contains 
the optimized needle voltage for your application. You must manually enter the 
optimal probe temperature and cone voltage into the instrument method.
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Figure 40. Save Tune Parameters dialog box

b. Type an appropriate name in the File name box.

c. Click Save to save the tune file with the optimized MS parameters for your 
compound of interest.

Note  Default tune files are read-only. 
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7

Creating Instrument Methods

You create an instrument method from the Instrument Setup window in the Xcalibur data 
system to automatically control the MSQ Plus Mass Detector and your LC devices during a 
sequence run.

This chapter describes the features of the method editing windows for the MSQ Plus Mass 
Detector and how to create an LC/MS instrument method that controls both your MSQ Plus 
Mass Detector and your LC devices.

Welcome Page
From the Welcome page for the MSQ Plus Mass Detector, shown in Figure 41, you can 
choose from a list of method templates, open existing method files, and access to the Tune 
window.

Contents

• Welcome Page

• Method Editor

• Creating an LC/MS Instrument Method
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Method Editor
Figure 41. MSQ Plus Mass Detector Welcome page in the Instrument Setup window

Method Editor
The MSQ Plus Mass Detector Method Editor contains the following views, tables, and 
menus, which are described in this topic:

• Method Options View

• Chromatogram View

• Per Method Parameters Table

• Full Scan Events Table

• SIM Scan Events Table

• Menus

You cannot have the Method Options view and the Chromatogram view open 
simultaneously, nor can you have the Full Scan Events and the SIM Scan Events tables open 
simultaneously. The Method Options view and the Full Scan Events table are shown in 
Figure 42. The Chromatogram view and the SIM Scan Events table are shown in Figure 43.
58 MSQ Plus Mass Detector Getting Started Guide Thermo Scientific



 7 Creating Instrument Methods
Method Editor
Figure 42. Method Editor with menus, method options, Per Method Parameters table, and Full Scan Events table visible

Method options

Menus

Hide Method Options 
bar

Full Scan Events 
table

Show SIM Scans bar

Per Method 
Parameters table
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Method Editor
Figure 43. Method Editor with menus, Chromatogram view, Per Method Parameters table, and SIM Events table visible

To switch between the Chromatogram view and the Method Options view, click the Hide 
Method Options or the Show Method Options bar. To switch between the SIM Scan Events 
table and the Full Scan Events table, click the Show SIM Scans or the Show Full Scans bar.

Method Options View

You can use the Method Options view shown in Figure 44 to do the following:

• Open an existing raw file so that you can preview a chromatogram.

• Use the settings in the current tune file or a specific tune file.

Chromatogram view

Menus

Show Method 
Options bar

SIM Scan Events table

Per Method 
Parameters table

Show Full Scans bar

CAUTION  The MSQ Plus Mass Detector stops acquiring data after completing all the 
mass detector's scan events. However, if the Continue to End of LC check box shown in 
Figure 42 on page 59 is enabled, the mass detector continues acquiring indefinitely or 
until you manually stop it.
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Chromatogram View

The Chromatogram view allows you to open a previously acquired raw file (a file with the 
.raw file extension) and display its chromatogram. You can right-click the chromatogram to 
display a spectrum view, which shows the most abundant ion at the selected retention time, as 
shown in Figure 44. You can also use the information in the raw file to edit the retention 
times for the scan events in your method.

Figure 44. Chromatogram view showing a mass spectrum displayed by right-clicking the chromatogram

Spectrum view
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You can use the Per Method Parameters table, shown in Figure 45, to select the ionization 
mode (ESI or APCI) and set the probe temperature. Typical probe temperature settings range 
from 350 °C to 650 °C, depending on the ionization mode and the flow rate of the mobile 
phase. See Table 1 and Table 2.

If the Per Methods Parameters table is not displayed, click the Show Per Method Parameters 
Table bar to display it.

Figure 45. Per Method Parameters table

Full Scan Events Table

Use the Full Scan Events table, shown in Figure 46, to define all the full-scan events that you 
want to acquire in your method. The parameters available to you in the Full Scan Events table 
are listed in Table 7. 

Figure 46. Full Scan Events table showing one full-scan event
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To perform source fragmentation, you can create two or more identical scan events, and then 
enter increasing cone voltages into the Cone (V) boxes. To perform polarity switching, you 
can create two identical scan events: one with the +ve polarity, and the other with the -ve 
polarity.

SIM Scan Events Table

Use the SIM Scan Events table shown in Figure 47 to monitor a limited number of 
mass-to-charge ratios, characteristic of a target compound or set of compounds. The mass 
analyzer switches between the selected mass-to-charge ratios, each value being monitored for a 
period of time (called the dwell time) before moving on to the next event.

SIM (selected ion monitoring) scan events offer the following:

• Improved sensitivity because more time is spent monitoring the ions of interest rather 
than scanning across the full mass range

• A wide and linear dynamic range without modification of the tuning parameters, which is 
important in isotope dilution techniques that use co-eluting labeled standards and in the 
analysis of trace components.

• Better definition of the chromatographic peaks because more data points can be recorded 
across each peak

• Reduced raw file sizes compared to a full scan because SIM scans record only a limited 
amount of data relating to the particular mass-to-charge ratio of interest

Table 8 lists the parameters available in the SIM Scan Events table.

Figure 47. SIM Scan Events table 

Menus

The Method Editor view has two menus, the Preview menu and the Scan menu, as shown in 
Figure 48.
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Figure 48. Method Editor menus 

Preview Menu

The Preview menu contains the following commands: All Scans, Full Scans, SIM Scans, and 
Parameters. With these commands, you can do the following:

• View scan events, defined in the Full Scan Events and SIM Scan Events tables, in the 
Chromatogram view.

• View and print a report of the method parameters.

To use the commands in the Preview menu

• Choose All Scans to display scan events, defined in both the Full Scan Events table and 
the SIM Scan Events table, in the Chromatogram view. 

A colored bar appears for each scan event; a full scan event is orange and a SIM scan event 
is green. If you hover the cursor over a bar, a tooltip showing the event name, start time, 
and end time appears.

• Choose Full Scans to display scan events, defined in the Full Scan Events table, in the 
Chromatogram view. Each scan event is displayed as an orange bar. If you hover the 
cursor over a bar, a tooltip showing the event name, start time, and end time appears.

• Choose SIM Scans to display scan events, defined in the SIM Scan Events table, in the 
Chromatogram view. Each scan event is displayed as a green bar. If you hover the cursor 
over a bar, a tooltip showing the event name, start time and end time appears.

• Choose Parameters to display a report of the method parameters. Click Print to print the 
report, or click Back to return to the Method Editor.

Scan Menu

The Scan menu contains the Add Full, Add SIM, Create Group, and Ungroup commands. 
With these commands, you can do the following: 

• Add and delete full and SIM scan events.

• Group and ungroup retention time ranges.
64 MSQ Plus Mass Detector Getting Started Guide Thermo Scientific



 7 Creating Instrument Methods
Creating an LC/MS Instrument Method
To use the commands in the Scan menu

• To add a full-scan event to the Full Scan Events table, choose Add Full. If you select a 
full-scan event, the new scan uses the values of the selected event. If do not select a scan, 
the values of the last row in the table are used.

• To add a SIM scan event to the SIM Scan Events table, choose Add SIM. If you select a 
SIM scan event, the new scan uses the values of the selected event. If you do not select a 
scan, the values of the last row in the table are used.

• To create a group for a particular time range, click the first SIM event that you want to 
add to the group. Pressing CTRL, click the events that you want to add. After you select 
the events that you want to group, choose Create Group. The group uses the time range 
and the polarity values listed in the first event. You can edit the time range and polarity 
parameters for the group.

• To ungroup the SIM events, choose Ungroup. If the individual events initially contained 
different settings for the time range, polarity, or both, they now contain the same settings 
as the group.

• To delete a scan event or a group, click the event or the group to select it, and then choose 
Delete.

Creating an LC/MS Instrument Method
To create an instrument method, follow the procedures in this section.

Opening the Instrument Setup Window

Opening the Instrument Setup window is the first step in creating an instrument method.

To open the Instrument Setup window

1. For Xcalibur 2.0.7, choose Start > Programs > Xcalibur > Instrument Configuration. 
In the Roadmap view of the Xcalibur Home Page, click the Instrument Setup icon.

–or–

For Xcalibur 2.1.x, choose Start > Programs > Thermo Xcalibur > Xcalibur to start 
Xcalibur. In the Roadmap view, click the Instrument Setup icon.

Note  Selected table rows are highlighted in green.

Tip  Before an individual SIM event or group of SIM events is performed, the mass 
detector performs a prefilter pulse to determine the baseline. To reduce the amount of 
time spent on performing prefilter pulses, group events that use the same time range, 
polarity, or both. 
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Specifying the Method Parameters for the MSQ Plus Mass Detector

To enter the instrument control parameters for the MSQ Plus Mass Detector, you can select a 
template or an existing method, or use the Method Editor to edit the method.

Selecting a Template or an Existing Method

You can select a template or an existing method from the Welcome page. 

To open the Welcome page and choose from among its options

1. Click the MSQ Plus button in the View bar of the Instrument Setup window to display 
the Welcome page, shown in Figure 49.

The View bar is a vertical bar on the left of the Instrument Setup window. It contains 
buttons for each of the instruments that you selected by using the Instrument 
Configuration program.

Figure 49. Welcome page for the MSQ Plus Mass Detector 

2. Select one of the options available to you:

• To create a new method, click a template for the type of acquisition that you want to 
perform. The Method Editor opens with the default parameters for the template.

• To edit an existing method, click the following link to display the Open dialog box:

Open an existing file.

In the Open dialog box, select a method, and click Open. Click the MSQ Plus 
button in the view bar of the Instrument Setup window to display the method in the 
Method Editor. 

• To open the Tune window, click the following link:
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Access to tune allowing you to optimize or modify the system 
settings.

Using the Method Editor to Edit the Method

To edit the method for the MSQ Plus Mass Detector, follow these procedures:

• Selecting the Method Options

• Selecting the Per Method Parameters

• Selecting the Scan Events

• Editing the Scan Events

Selecting the Method Options

Select the method options in the Method Editor view.

To select the method options in the Method Editor view

1. From the Method Editor, click the Show Method Options bar to open the Method 
Options view shown, in Figure 50.

Figure 50. Method Editor with the Method Options view 

2. If you cannot see the browse buttons in the Method Options view, click the Hide Per 
Method Parameters bar to hide the Per Method Parameters table.

3. (Optional) Open a raw file and display its chromatogram:

a. Click the browse button next to the Rawfile box.

b. From the Open dialog box, select a raw (.raw) file.

c. Click Open to close the Open dialog box and open the raw file.

d. Click the Hide Method Options bar to display the Chromatogram view.
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You can use the chromatogram to edit the retention times of your scan events, as 
described in “Editing the Scan Events” on page 70.

e. After you finish working the chromatogram, click the Show Method Options bar to 
reopen the Method Option view.

4. Select a tune (.tune) file by doing one of the following:

• Select the Use Current Tune File check box to use the Tune file that is in the current 
memory of the Xcalibur data system.

• Clear the Use Current Tune File check box. Click the browse button next to the Use 
Selected Tune file box to display the Open dialog box. Select the Tune file that you 
created for your analyte, and then click Open.

5. To stop the acquisition after completing all the mass detector's scan events, clear the 
Continue to End of LC check box, shown in Figure 42 on page 59. 

Selecting the Per Method Parameters

The “per method” parameters for the MSQ Plus Mass Detector are the ionization mode and 
the probe temperature.

To select the ionization mode and enter the probe temperature

1. If the Per Method Parameters table is not displayed, open it by clicking the Show Per 
Method Parameters bar.

2. If you want to change the ionization mode, click the Ionization Mode Setpoint, and 
select an appropriate ionization mode for your application.

3. To change the probe temperature, click the Probe Temperature Setpoint box. Type an 
appropriate probe temperature in the box, and then press ENTER.

Selecting the Scan Events

Table 7 lists the allowable ranges for the parameters in the Full Scan Events table. Table 8 lists 
the allowable ranges for the parameters in the SIM Scan Events table. 

Note  For ESI methods, the instrument method uses the needle voltage value 
from the Tune file. For APCI methods, the instrument method uses the corona 
current value from the Tune file. 

Note  The probe temperature setting is not imported with the tune file. Use the 
temperature that you determined empirically when you optimized the tune 
parameters for your analytes. 
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Your method can contain both SIM scan events and full-scan events. 

• Use SIM (selected ion monitoring) scan events for trace analysis and quantitation. 

• Use full-scan events for rapid screening and qualitative analysis.

Table 7. Full Scan Events table parameters

Parameter Range Entry

Name Alphanumeric characters Click the Name box and type a name consisting of alphanumeric 
characters.

Mass Range 1.00–2000.00 Click the Mass Range box and type the beginning mass, a hyphen, 
and the ending mass.

Time Range 0.00–9999.00 Click the Time Range box and type the beginning timepoint, a 
hyphen, and the ending timepoint.

Peak Format Centroid or Profile Click the Peak Format list and select Centroid or Profile from the list.

Scan Time 0.01 to 8.00 Click the Scan Time box and type a length of time for the scan. 
Typical values range between 0.25 and 1.0.

Polarity +ve or -ve Click the Polarity list and select +ve or -ve from the list.

Cone (V) 0.00 to 200.00
(typical 70.00 to 150.00)

Click the Cone (V) box and type the value of the optimal cone 
voltage for your application.

Table 8. SIM Scan Events table parameters

Parameter Range Entering

Name Alphanumeric characters Click the Name box and type a name consisting of alphanumeric 
characters.

Mass 1.00–2000.00 Click the Mass Range box and type the m/z ratio of the ion that you 
want to monitor.

Span 0.00 to 1998 Click the Span box and type an appropriate span (m/z). For SIM scan 
events, typical values range between 0.05 and 0.5. 

Time Range 0.00–9999.00 Click the Time Range box and type the beginning timepoint, a 
hyphen, and the ending timepoint. 

Dwell Time 0.01 to 8.00 Click the Scan Time box and type a length of time for the scan. 
Typical values range between 0.05 and 0.25.

Polarity + ve or –ve Click the Polarity list and select +ve or –ve from the list.

Cone (V) 0.00 to 200.00
(typical 70.00 to 150.00)

Click the Cone (V) box and type the value of the optimal cone 
voltage for your application.
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Editing the Scan Events

You can manually edit scan events, as described in Table 7 and Table 8 or you can edit scan 
events by using the information stored in a previously acquired raw data file as described 
below. 

To change the start or end time of an event with the Chromatogram view

1. Click a scan event in either the Full Scan Events or the SIM Scan Events table to select it.

2. Place the cursor at either end of the colored bar:

• If your cursor is at the left end of the bar, it will change to a right arrow .

• If your cursor is at the right end of the bar, it will change to a left arrow .

3. Drag the cursor to the retention time that you want. 

A pop-up window appears, showing the event name, start time, end time, and duration to 
assist in the positioning of the cursor. The new values are automatically updated in the 
Time Range column of the events table, ,as shown in Figure 51.

Figure 51. Pop-up window that appears when you adjust the start or end time of a scan event

4. To move the scan window of an event, place the cursor on the colored bar. It will change 
to this icon, .

5. Drag the bar to the retention time window that you want. 

A pop-up window appears, showing the event name, start time, end time, and duration to 
assist in the positioning of the bar. The new values are automatically updated in the Time 
Range column of the events table.

Specifying the Method Parameters for the LC System

In the Instrument Setup view, icons for all of the currently configured instrument 
components appear on the left side of the view. Instrument Setup pages and dialog boxes for 
the selected instrument component appear on the right side of the view.

To create an instrument method that controls your LC system

1. Select the device that you want to set up by clicking its icon in the View bar.

The Xcalibur data system displays the Instrument Setup view for the instrument that you 
selected. This view can consist of one or more pages or dialog boxes.

2. Select the Instrument Setup options that are appropriate for your application.
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Saving the Method

You can save the instrument method in a .meth file.

To save the instrument method in a .meth file

1. Choose File > Save As to open the Save As dialog box, shown in Figure 52.

Figure 52. Save As dialog box

2. Browse through the directory tree to find the Drive:\Xcalibur\methods directory.

3. Type a file name in the File Name box.

4. Click Save to open the File Summary Information dialog box, shown in Figure 53.
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Figure 53. File Summary Information dialog box 

5. Type a description of the Method file in the Description box.

6. Click OK to open the File Save – Audit Trail dialog box, shown in Figure 54.

Figure 54. File Save – Audit Trail dialog box 
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7. Type a comment concerning the changes you made to the instrument method into the 
Comment box.

8. Click Continue to close the File Save – Audit Trail dialog box and save the 
Instrument Method.
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Creating and Running Sequences

This chapter describes how to acquire and view real-time data for a single sample.

Creating a Single Sample Sequence
To set up a sequence to inject a single sample, open the Sequence Setup window, create the 
sequence, and save the sequence.

Opening Sequence Setup Window

From the Sequence Setup view, you can open the New Sequence Template dialog box.

To open the New Sequence Template dialog box

1. Click the Sequence Setup icon, , on the Xcalibur Roadmap view to open the 
Sequence Setup view.

A view similar to that shown in Figure 55 appears.

Figure 55. Sequence Setup view

Contents

• Creating a Single Sample Sequence

• Starting Data Acquisition

• Viewing the Data as It Is Acquired
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2. From the Sequence Setup view, choose File > New.

A New Sequence Template dialog box similar to the one shown in Figure 56 appears. The 
tray type and vial selections depend on the configuration of the autosampler.

Figure 56. New Sequence Template dialog box for an LC/MS with an Accela autosampler 
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Creating the Sequence

Follow these steps to create a new sequence.

To create a new sequence

1. Set the parameters in the General area:

a. Type a name for the raw data file into the Base File Name box.

b. Browse to the data file directory where you want to store your raw data files. 

The data system adds the .raw file extension to the data files that contain the 
chromatographic and spectral data. 

c. Browse to the instrument method that you want to use to acquire your raw data files.

Instrument methods have a .meth file extension. For information on creating an 
instrument method, refer to the Help. For more detailed information on controlling 
the Accela LC system, refer to your manual.

d. If you have not yet created a processing method that contains the information needed 
to quantify your unknowns, leave the Processing Method box blank. 

You can create a processing method and reprocess your stored data files at a later date. 
Processing methods have a .pmd file extension.

2. Set the parameters in the Samples area:

a. Type 1 in the Number Of Samples box.

b. Type 1 in the Number Of Injections box.

c. Type the vial position in the Initial Vial Location box.

d. Type an identifying name for the sample in the Base Sample ID text box.

e. Labeling a sample with a base sample ID is optional. If you do not enter a base 
sample ID, the data system automatically uses the vial position as the base sample ID. 
If you enter a base sample ID, the data system automatically appends the vial position 
to your entry.

3. Click OK to open your sequence spreadsheet, as shown in Figure 57.

Figure 57. Sequence Setup view, showing a newly created one-line sequence
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The injection volume displayed in the Inj Vol column matches the injection volume 
contained in your instrument method. You can override this injection volume value.

4. If you want to change the injection volume, double-click the spreadsheet cell containing 
the injection volume value that you want to change, highlight the current value, and type 
a new value in the cell. You can use the Column Arrangement icon, , to make the 
column cell visible.

For details on the parameters in the New Sequence Template dialog box, refer to the 
Xcalibur Help or the following documents:

• For the Xcalibur 2.0.7 data system, refer to the Xcalibur Getting Productive: 
Qualitative Analysis or Quantitative Analysis manual. 

• For the Xcalibur 2.1.x data system, refer to the Thermo Xcalibur Qualitative Analysis 
User Guide or the Thermo Xcalibur Quantitative Analysis User Guide.

5. To alter the current column arrangement, click the Column Arrangement toolbar 
button to display the Column Arrangement dialog box, shown in Figure 58.

• To add a column to the sequence, select the column from the Available Columns list 
and click Add.

• To remove a column from the sequence, select the column from the Displayed 
Columns list and click Remove.

• To alter the position of the columns in the sequence, select the column from the 
Displayed Columns list, and click either Move Up or Move Down as appropriate.

Figure 58. Column Arrangement dialog box 
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Saving the Sequence

Save the sequence by following this procedure.

To save the sequence

1. Choose File > Save As.

The File Summary Information dialog box appears, as shown in Figure 59.

Figure 59. File Summary Information dialog box 

2. Type an appropriate description in the Description box, and click OK.

The Save As dialog box appears, as shown in Figure 60.
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Figure 60. Save As dialog box

3. Browse to the appropriate folder where you want to save the sequence. 

4. Type a file name in the File Name box.

5. Click Save.

Starting Data Acquisition
To inject a sample and start data acquisition, open a sequence file, select the row that you 
want to run, select the run options, and start the run.
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Opening a Sequence File

Start data acquisition by opening a sequence file containing the sample that you want to run.

To open a sequence file

1. From the Sequence Setup view in the Xcalibur Roadmap view, choose File > Open to 
display the Open dialog box, shown in Figure 61.

Figure 61. Open dialog box showing the selection of a sequence file

2. Browse to the appropriate folder. 

3. Select the sequence that contains the sample you want to run.

4. Sequence files are identified by their .sld file extension.

5. Click Open.

The Xcalibur data system opens the selected sequence.
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Selecting the Rows That You Want to Run

Next, select the rows that you want to run.

To select the row or rows that you want to run

1. Highlight the sequence row or rows that you want to run, even if the sequence contains 
just one row. See Figure 62.

Figure 62. Sequence Setup view showing sequence with first row selected

2. Confirm that you have vials in the positions specified in the sequence rows that you plan 
to run.

Selecting the Run Options and Starting the Run

Follow these steps to select the run options and start the run.

To select the run options and start the run

1. From the toolbar, click the Run Sample icon, , to open the Run Sequence dialog box, 
shown in Figure 63.
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Figure 63. Run Sequence dialog box 

The User box contains your login name, and the Run Rows box contains the number of 
the row that you selected in the sequence spreadsheet.

2. In the Acquisition Options area, confirm the following:

• The mass detector and LC components are configured for operation as Xcalibur 
devices in the Instrument list. 

• The autosampler is configured as the start instrument.

After the injection valve of the autosampler switches to the inject position, the 
autosampler sends a signal to the detector to begin data collection.

3. To change the components of your LC system or change the device that starts the run, do 
the following: 

a. Click Change Instruments to open the Change Instruments In Use dialog box, 
shown in Figure 64.
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Figure 64. Change Instruments In Use dialog box 

A list of components that have been configured for operation as Xcalibur devices 
appears. The autosampler is typically selected as the start instrument.

b. Add or remove components as appropriate.

c. To select a start instrument in the Instrument list, click the Start Instrument list in 
the row of the instrument of choice. The blank space changes to display “Yes.”

4. To start the run automatically, select the Start When Ready check box. 

The Xcalibur data system starts the run after you click OK in the Run Sequence 
dialog box. If your system contains an Accela pump, the run begins after the pump sends 
a pump ready signal to the Accela autosampler. The Accela pump is not ready until it 
monitors a stable backpressure, as defined in the instrument method.

5. In the After Sequence Set System area, make the following selections:

• Select the On option if you want Xcalibur to leave the devices in the On state after 
the sequence ends.

• Select the Off option if you want Xcalibur to turn off the pump flow and place the 
mass detector in the Off mode after the sequence ends. In the Off mode, the nitrogen 
gas, probe heater, and high voltages are turned off. If your instrument contains a UV 
detector, Xcalibur turns off the detector’s lamps.

• Select the Standby option if you want to the LC pump flow to stop after the 
sequence ends.

Note  To manually start an acquisition, clear the Start When Ready check box and 
choose Actions > Start Analysis from the Sequence Setup menu. To subsequently 
control the acquisition, choose Actions > Pause Analysis or Actions > Stop 
Analysis.

Note  The MSQ Plus Mass Detector application has no standby mode. If you are 
actively developing an instrument method, leave the system on. Otherwise, turn 
the system off at the end of a sequence to save nitrogen gas. The probe heater will 
reach equilibrium temperature in 1 to 2 minutes when you turn the system back 
on. 
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6. Leave the parameters in the other areas at their defaults. 

Use the Instrument Method and Programs areas in the Run Sequence dialog box to 
specify particular acquisition or processing requirements. For details on these parameters, 
refer to the Help or Thermo Xcalibur Acquisition and Processing User Guide.

7. Click OK to start the run.

Viewing the Data as It Is Acquired
You can view the data as it is acquired by using the real-time plot facilities.

To view the data as it is acquired using the real-time plot facilities

1. Click the Real Time Plot View icon, , on the Roadmap view toolbar. 

The screen is automatically locked so you can view the progress of your run in real time.

2. If you want to freeze the run data, click the Unlocked icon, .

When the screen is unlocked, you cannot monitor the real-time progress of your run, but 
you can review your data. For example, you can display the spectrum for a particular peak 
that has already eluted. Data collection continues off screen as you review your data.

3. To re-lock the display, click the Locked icon, . 

Reviewing Real-Time Data

Follow this procedure to review the data as it is being collected.

To review the data as it is being collected

1. Unlock the display by clicking the Locked icon, .

After you unlock the display, data collection continues off screen.

2. Pin the Mass Spectrum cell by clicking the pin icon, , in the upper right corner of 
the cell.

The pin in the upper right corner of the Mass Spectrum cell turns green. Cursor actions 
in other cells, such as the chromatogram cell, now affect the view displayed in the 
Spectrum cell.

3. Click the peak of interest in the Chromatogram cell.

In the Mass Spectrum cell, a mass spectrum appears for the time point that you 
clicked on.

4. To resume monitoring real-time data acquisition, click the Locked icon, , again to 
lock the display.
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5. Pin the Chromatogram cell by clicking the pin in the upper right corner of the cell.

The pin in the upper right corner of the Chromatogram cell turns green. Cursor actions 
in other cells, such as the Spectrum cell, now affect the view displayed in the 
Chromatogram cell.

6. Click the m/z value of interest in the Mass Spectrum cell.

In the Chromatogram cell that contained the total ion chromatogram (TIC), a 
chromatogram appears for the m/z value that you clicked.

7. To resume monitoring real-time data acquisition, click the Locked icon, .

Adding Cells to the Display

You can display multiple cells in the real-time display view. 

To display multiple chromatogram cells

1. Click the Chromatogram cell to make it the active cell with a gray border.

2. Choose View > Ranges to open the Chromatogram Ranges dialog box, as shown in 
Figure 65.

Figure 65. Chromatogram Ranges dialog box
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3. For each cell that you want to add, do the following:

a. Select a Type check box. 

b. From the Detector list, select a detector.

c. From the Plot Type list, select a plot type.

4. Click OK to close the Chromatogram Ranges dialog box.

5. Choose View > Lock Display to resume monitoring real-time data acquisition.

Figure 66 shows the four traces resulting from the settings in the Chromatogram Ranges 
dialog box:

1. The total ion chromatogram (TIC)

2. The extracted ion chromatogram for the mass range: 180 to 220 m/z

3. Base peak chromatogram for the masses: 182 and 213 m/z

4. UV chromatogram at 260 nanometers

Figure 66. Four traces generated by settings in the Chromatogram Ranges dialog box
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Using Qual Browser

This chapter provides an introduction to using Qual Browser, a facility that you can use to 
review the MS data contained in your data files. 

Cell States
When you open a raw data file in the Qual Browser window, the information within the data 
file is displayed as a grid of cells. There are three hierarchical states, which are described in this 
topic, for a cell within the grid:

• Inactive Cells

• Active but Unpinned Cells

• Active and Pinned Cells

The grid always contains either one active but unpinned cell or one pinned cell. If the grid 
contains more than one cell, only one cell can be active, and the rest of the cells are inactive.

An unpinned cell has a gray pin icon, , in its upper right corner.

A pinned cell has a green pin icon, , in its upper right corner.

Contents

• Cell States

• Cursor Actions

• Opening a Raw Data File in Qual Browser

• Adding Cells to the Grid

• Viewing Reports

• Viewing the Mass Spectrum for a Specific Time Point
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Inactive Cells

Inactive cells are not highlighted with a gray border, and the pin icon in their upper right 
corners are gray. The cell in the lower portion of Figure 67 is inactive, as indicated by the 
absence of a gray border. Menu commands, toolbar buttons, and cursor actions do not affect 
inactive cells. If you want to zoom the contents of a cell or access its shortcut menu, you must 
make it an active cell.

Active but Unpinned Cells

An active but unpinned cell is highlighted with a gray border, and the pin icon in its upper 
right corner is gray. The cell in the upper portion of Figure 67 is active but unpinned. Menu 
commands, toolbar buttons, and cursor actions affect the active cell. If no cell in the grid is 
pinned, clicking an inactive cell in the grid makes it the active cell.

Active and Pinned Cells

Clicking a pin in the upper right corner of a cell makes it the pinned cell within the grid. A 
pinned cell is an active cell that cannot be made inactive by clicking in another cell. Instead, 
actions performed in the inactive cells affect the pinned cell, as described in “Cursor Actions” 
on page 92. The lower cell in Figure 68 is a pinned cell.

If you want to automatically change the range of a cell by clicking in the grid, you must pin 
the cell. For example, if you want to display the spectrum for the 1 minute time point without 
opening the Spectrum Ranges dialog box, pin the Spectrum cell. Then, click the 1 minute 
time point in the inactive chromatogram cell.
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Figure 67. Qual Browser window displaying an active TIC chromatogram cell and an inactive mass spectrum cell

Figure 68. Qual Browser window displaying an inactive cell and a pinned cell
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Gray border Active cell

Inactive cell

Inactive cell

Pinned cell
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Cursor Actions
Within the cells of the grid, you can use the cursor in three ways:

• Click in the cell to select a point.

• Drag a line parallel to any axis to select a range.

• Drag a line in any diagonal direction to select an area.

The effect of these actions depends on the state of the cell. Within an active cell, cursor 
actions rescale the plot in the ways shown in Table 9. If one of the cells is pinned, the cursor 
action in any of the inactive cells is always applied to the pinned cell, as shown in Table 10.

Opening a Raw Data File in Qual Browser
The data files containing the raw chromatographic and spectral data have the .raw file 
extension. 

To open a raw file in Qual Browser

1. Click the Qual Browser icon on the Xcalibur Roadmap view, or choose Go To > Qual 
Browser to display the empty Qual Browser window, shown in Table 69.

Table 9. Effect of cursor action in an active cell

Cursor action Effect

Drag parallel to X axis Rescale graph showing selected x range only, same y range.

Drag parallel to Y axis Rescale graph showing selected y range only, same x range.

Dragged area Rescale graph showing both the selected x and y ranges.

Table 10. Effect of cursor action in an inactive cell on the pinned cell

Pinned cell Cursor action Effect

Spectrum Click in a chromatogram cell The spectrum cell displays the 
spectrum at that retention time.

Chromatogram Click in a spectrum cell The chromatogram cell displays 
chromatogram for the wavelength 
selected in the spectrum cell.
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Opening a Raw Data File in Qual Browser
Figure 69. The empty Qual Browser window in the Xcalibur data system

2. Choose File > Open to display the Open Raw File dialog box, shown in Figure 70.

Figure 70. Open Raw File dialog box

3. Select the raw file that contains the data for the sample that you want to work on.

4. Select the window layout from the list at the bottom of the dialog box:

• Select Current Layout if the current layout for the Qual Browser window is different 
from the default layout and you want to apply it to your data file. 
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• Otherwise, leave the window layout selection at its default of Default Layout. 

5. Click Open to open the raw file into the Qual Browser window.

Adding Cells to the Grid
You can add cells to the grid in Qual Browser.

To add cells to the grid in Qual Browser

1. Open a raw file in Qual Browser.

2. From the Qual Browser menu bar, choose Grid > Insert Cells. 

3. Choose Left, Right, Above, or Below.

4. Right-click the cell that you just inserted into the grid to access a shortcut menu, as 
shown in Figure 71.

Figure 71. View of Qual Browser window with the shortcut menus for selecting the options for a cell

5. From the shortcut menu, choose the view that you want for this cell.
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Viewing Reports 
After you open a data file, you might want to check the instrument parameters that were used 
to acquire it. 

To view a report that lists the instrument control parameters used to acquire the 
data file

1. Open a raw data file in the Qual Browser facility, as described in “Opening a Raw Data 
File in Qual Browser” on page 92.

2. Choose View > Report > Instrument Method to display the Instrument Method report.

The instrument method is displayed in the pinned cell. The instrument method is 
divided by device, with the parameters for each device displayed on a separate page. 
Figure 72 shows an Instrument Method report.

Figure 72. Report for an instrument method 

3. Click the Show Previous and Show Next buttons, , to move through the pages 
of your acquisition method.

4. Choose View > Report > Status Log to display the Status Log report.

The status log displays the settings that were imported from the tune file, as shown in 
Figure 73.
Thermo Scientific MSQ Plus Mass Detector Getting Started Guide 95



9 Using Qual Browser
Viewing Reports
Figure 73. Status log showing needle voltage

5. Choose View > Report > Tune Method to display the Tune Method report. 

The Tune Method report displays the settings that were determined during the 
full-system autotune procedure, as shown in Figure 74.
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Viewing the Mass Spectrum for a Specific Time Point
Figure 74. Report for autotune settings 

The non-zero and non-unity values for the three coefficients indicate that a successful 
autotune has been stored on this system. 

A clean installation or a reinstallation of the software might reset the RF Frequency, HM Res 
Mid Point, and Detector Voltage parameters to default values. For optimized settings, refer to 
a previously successful autotune report.

Viewing the Mass Spectrum for a Specific Time Point
You can view a mass spectrum for a specific time point in the chromatogram.

To view a spectrum for a specific time point in the chromatogram

1. Open a raw data file into the Qual Browser facility.

2. If the grid does not contain both a Chromatogram cell and a Spectrum cell, add the 
appropriate cell to the grid, as described in “Adding Cells to the Grid” on page 94.

3. Pin the Spectrum cell.

4. In the Chromatogram cell, click a time point that you are interested in.

The mass spectrum for the selected time point appears in the Spectrum cell, as shown in 
Figure 75.
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Viewing the Mass Spectrum for a Specific Time Point
Figure 75. Qual Browser window displaying the mass spectrum for the 3.76 minute time point
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Sample Formulations

This appendix provides instructions for preparing the sensitivity testing solutions and the 
calibrant solution. A Thermo Fisher Scientific field service engineer uses the 5 pg/μL solution 
of erythromycin to perform the sensitivity tests for the positive ion ESI and APCI modes and 
the 2 pg/μL solution of p-nitrophenol to perform the sensitivity tests for the negative ion ESI 
and APCI modes. The calibrant solution for systems running on the MSQ 2.0 software 
version contains the reference compounds [(CsI, KI, and NaI in 50:50 isopropanol/water 
(v/v)] that are used to perform a full-system autotune and a mass-scale calibration.

Material safety data sheets (MSDS) summarize information on the hazard and toxicity of 
specific chemical compounds. They also describe the proper handling of compounds, first aid 
for accidental exposure, and procedures for cleaning up spills or leaks. Producers and suppliers 
of chemical compounds are required by law to provide their customers with the most current 
health and safety information in the form of an MSDS. Read the material safety data sheets 
for each chemical you use.

Contents

• Sensitivity Test Solutions

• Preparing the MSQ Plus Mass Detector Calibration Solution

• Calibrant Solution

CAUTION  Always take safety precautions when you handle chemicals and unknown 
samples. Ensure that you read and understand the hazards of the chemicals used in the 
following preparations. Dispose of all laboratory reagents by the appropriate method for a 
specific reagent or solvent.

CAUTION  Avoid exposure to potentially harmful materials. Always wear protective gloves 
and safety glasses when you use solvents or corrosives. Also, contain waste streams and use 
proper ventilation. Refer to your supplier’s material safety data sheets (MSDS) for 
procedures that describe how to handle a particular solvent, corrosive substance, or both.
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Sensitivity Test Solutions
The MSQ Sensitivity Test Kit (part number FM104284) contains two 25 mL glass vials. One 
vial contains 10 mg of erythromycin, and the other vial contains 10 mg of p-nitrophenol. The 
stock solutions, which can be stored under refrigeration for up to three months, are prepared 
by adding 10 mL of solvent to each of these vials. The working solutions that are used to 
perform the sensitivity test are prepared by diluting aliquots of the stock solutions. 

Preparing the Stock Solutions for the Sensitivity Tests

The field service engineer uses two compounds to perform sensitivity testing. Erythromycin is 
used to test the sensitivity of the instrument in the positive ion mode. P-nitrophenol is used to 
test the sensitivity of the instrument in the negative ion mode.

Stock Solution: Erythromycin

Follow this procedure to perform sensitivity testing with erythromycin.

To prepare a 1 mg/mL (1μg/μL) stock solution of erythromycin in 100% HPLC-grade 
acetonitrile

1. Open the 25 mL glass vial that contains 10 mg of erythromycin.

2. Using a 10 mL volumetric pipette or an adjustable, mechanical pipette, add 10 mL of 
HPLC-grade acetonitrile to the vial.

3. Screw the cap back onto the vial and mix.

4. Label the vial Erythromycin Stock Solution.

5. Store the erythromycin stock solution (1 mg/mL) in a refrigerator until it is needed. 

When refrigerated, this stock solution is stable for several months.

Stock Solution: P-Nitrophenol

Follow this procedure to perform sensitivity testing with p-nitrophenol.

To prepare a 1 mg/mL (1mg/mL) stock solution of p-nitrophenol in 100% HPLC-grade 
methanol

1. Open the 25 mL glass vial that contains 10 mg of p-nitrophenol.

2. Using a 10 mL volumetric pipette or an adjustable, mechanical pipette, add 10 mL of 
HPLC-grade methanol to the vial.

3. Screw the cap back onto the vial and mix.

4. Label the vial P-Nitrophenol Stock Solution.
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5. Store the p-nitrophenol stock solution (1 mg/mL) in a refrigerator until it is needed. 
When refrigerated, this stock solution is stable for several months.

Preparing the Working Solutions for the Sensitivity Tests

A working solution of 5 pg/μL erythromycin in 50:50 acetonitrile/water and a working 
solution of 2 pg/μL p-nitrophenol in 50:50 methanol/water are required to perform the 
sensitivity tests. Prepare these working solutions daily as needed from the refrigerated stock 
solutions. The following procedures require the materials listed in Table 11 or their 
equivalents. 

Preparing the Erythromycin Sensitivity Test Solution

Use this procedure to prepare the erythromycin sensitivity test solution.

To prepare 10 mL of the erythromycin sensitivity test solution 

1. Allow the 1 mg/mL (1 μg/μL) stock solution of erythromycin to equilibrate to room 
temperature. Then dilute it 100-fold:

a. Using a 200 μL adjustable pipette, transfer 100 μL of the stock solution of 
erythromycin into a clean, dry 25 mL glass vial.

b. Using a 10 mL adjustable pipette, add 9.9 mL of 50:50 acetonitrile/water (v/v) to the 
vial, and mix the solution.

c. Label the resulting solution 10 ng/μL Erythromycin.

2. Dilute the 10 ng/μL solution of erythromycin 100-fold:

a. Using a 200 mL adjustable pipette, transfer 100 mL of the 10 ng/mL solution of 
erythromycin into a clean, dry 25 mL glass vial.

Table 11. Required materials

Item Quantity

200 μL adjustable, mechanical pipette (calibrated) or equivalent 1

1 mL adjustable, mechanical pipette (calibrated) or equivalent 1

10 mL adjustable, mechanical pipette (calibrated) or equivalent 1

25 mL glass vials with caps or equivalent 6

50:50 acetonitrile/water (v/v), premixed 30 mL

50:50 methanol/water (v/v), premixed 30 mL

Note  The following procedures result in a 200000-fold dilution of the erythromycin 
stock solution and a 500000-fold dilution of the p-nitrophenol stock solution. Alternative 
dilution procedures that result in a 5 pg/μL solution of erythromycin and a 2 pg/μL 
solution of p-nitrophenol with a reasonable level of accuracy are acceptable.
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b. Using a 10 mL adjustable pipette, add 9.9 mL of 50:50 acetonitrile/water (v/v) to the 
vial, and mix the solution.

c. Label the resulting solution 100 pg/μL Erythromycin.

3. Dilute the 100 pg/μL solution of erythromycin 20-fold:

a. Using a 1 mL adjustable pipette, transfer 0.50 mL of the 100 pg/mL erythromycin 
solution into a clean, dry 25 mL glass vial.

b. Using a 10 mL adjustable pipette, add 9.5 mL of 50:50 acetonitrile/water (v/v) to the 
vial, and mix the solution.

c. Label the resulting solution 5 pg/μL Erythromycin.

Preparing the P-Nitrophenol Sensitivity Test Solution

Use this procedure to prepare the p-nitrophenol sensitivity test solution.

To prepare 10 mL of the p-nitrophenol sensitivity test solution 

1. Allow the 1 mg/mL (1 μg/μL) stock solution of p-nitrophenol to equilibrate to room 
temperature. Then, dilute it 100-fold:

a. Using a 200 μL adjustable pipette, transfer 100 μL of the stock solution of 
p-nitrophenol into a clean, dry 25 mL glass vial.

b. Using a 10 mL adjustable pipette, add 9.9 mL of 50:50 methanol/water (v/v) to the 
vial, and mix the solution.

c. Label the resulting solution 10 ng/μL P-nitrophenol.

2. Dilute the 10 ng/μL solution of p-nitrophenol 100-fold:

a. Using a 200 μL adjustable pipette, transfer 100 μL of the 10 ng/μL solution of 
erythromycin into a clean, dry 25 mL glass vial.

b. Using a 10 mL adjustable pipette, add 9.9 mL of 50:50 methanol/water (v/v) to the 
vial, and mix the solution.

c. Label the resulting solution 100 pg/μL P-nitrophenol.

3. Dilute the 100 pg/μL solution of p-nitrophenol 50-fold:

a. Using a 200 mL adjustable pipette, transfer 200 μL of the 100 pg/μL p-nitrophenol 
solution into a clean, dry 25 mL glass vial.

b. Using a 10 mL adjustable pipette, add 9.8 mL of 50:50 methanol/water (v/v) to the 
vial, and mix the solution.

c. Label the resulting solution 2 pg/μL P-nitrophenol.
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Preparing the MSQ Plus Mass Detector Calibration Solution
This section describes how to prepare the MSQ Plus Mass Detector calibration solution for autotune 
and mass calibration. You can also find these instructions in the MSQ Plus Mass Detector Calmix Kit 
Preparation Guide. 

Kit Contents

The MSQ Plus Mass Detector Calmix Kit (Part Number 60111-62021) includes a 
concentrated stock calibration solution of three inorganic salts, with the following 
concentrations:

• Sodium iodide (NaI): 130 mM

• Potassium iodide (KI): 5 mM

• Cesium iodide (CsI): 2 mM

The inorganic salts are dissolved in 2.5 mL (± 1%) of solvent and packaged in a sealed 
ampoule. The solvent is a 92:8 mixture of HPLC-grade water (H2O) and reagent-grade 
isopropanol (IPA). The neck of the ampoule is scored for easy and safe opening.  

Three ampoules and three labels are included in the Calmix Kit.  The labels denote the 
expiration date (36 months from date of manufacture), the lot number, and the Thermo 
Fisher Scientific and supplier-provided part numbers. The Calmix Kit contains a gravimetric 
certificate of analysis corresponding to the lot number. It also includes the Material Safety 
Data Sheet (MSDS) for the calibration solution.

Preparing the Calibration Solution 

Follow these steps to prepare the calibration solution.

To prepare the working concentration of calibration solution

1. In a graduated cylinder, prepare 250 mL (± 20 mL) of diluent:

• 125 mL (± 10 mL) of HPLC-grade H2O

• 125 mL (± 10 mL) of reagent-grade IPA

2. Transfer 100 mL (± 10 mL) of the diluent from the graduated cylinder to the 250 mL 
Nalgene bottle that is attached to the front panel (inlet side) of the MSQ Plus Mass 
Detector.

Note  The efficacy of the calibration solution depends on high-quality diluent 
and clean glassware, because the solvent adducts must be properly formed in the 
electrospray source and the reference masses must be detected against the 
background of electronic and chemical noise. 
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3. Transfer the entire contents of a single ampoule to the Nalgene bottle. You can use a 
transfer pipet to facilitate the transfer.

4. Transfer the remaining volume of the diluent from the graduated cylinder to the Nalgene 
bottle.

5. Attach one of the labels from the Calmix Kit to the Nalgene bottle.

6. Firmly seal the Nalgene bottle of the MSQ Plus Mass Detector inlet reservoir and mix the 
solution by swirling the bottle.

7. Once the autotune and mass calibration process is complete, bypass the injection valve by 
attaching the transfer line from the HPLC system to the grounded union on the front 
panel of the mass detector. This last step does not apply to MSQ systems that are 
grounded through the injection valve—that is, released before January 2005 (serial 
number below 201 xx). 

Calibrant Solution
The automated full-system autotune and mass-scale calibration procedures use a calibrant 
solution that contains a mixture of 1.3 mM sodium iodide (NaI), 0.05 mM potassium iodide 
(KI), and 0.02 mM cesium iodide (CsI) in a solution of 50:50 isopropanol/water. You can 
purchase this calibrant solution as a new kit (part number 60111-62021) containing Calmix 
concentrate and instructions. This material ships with each new MSQ Plus Mass Detector as 
part of the MSQ chemical kit (part number 60111-62023). Or, you can prepare the solution 
yourself, using the procedures in this section. 

Preparing the calibrant solution requires the materials and equipment listed in Table 12 or 
their equivalents. 

To prepare 250 mL of calibrant solution, follow these procedures:

1. Preparing a Concentrated Stock Solution of the Calibration Mixture

2. Preparing the Working Calibration Solution

Note  The Nalgene bottle is pressurized from 1.0 to 1.5 bar during the autotune and 
mass calibration process, requiring a leak-tight seal.

Table 12. Materials and equipment required to prepare calibrant (Sheet 1 of 2)

Materials and equipment Quantity

Cesium iodide (CsI), > 99.9% pure Approx. 300 mg

Potassium iodide (KI), A.C.S. reagent grade Approx. 500 mg

Sodium iodide (NaI), A.C.S. reagent grade Approx. 10 g

HPLC-grade water Approx. 200 mL

Isopropanol Approx. 200 mL
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Preparing a Concentrated Stock Solution of the Calibration Mixture

The stock solution contains 10 mM cesium iodide (MW 259.8 g/mole), 25 mM potassium 
iodide (MW 166.0 g/mole), and 650 mM sodium iodide (MW 149.9 g/mole) in 50:50 
isopropanol/water.

To prepare a stock solution of the calibration mixture

1. Add 50 mL of HPLC-grade water to the 125 mL Erlenmeyer flask.

2. Weigh out 260 mg ± 10 mg of cesium iodide. Then, quantitatively transfer the cesium 
iodide to the flask. Record the actual weight, manufacturer, and lot number of the cesium 
iodide (CsI) used. 

3. Weigh out 415 mg ± 10 mg of potassium iodide. Then, quantitatively transfer the 
potassium iodide to the flask. Record the actual weight, manufacturer, and lot number of 
the potassium iodide (KI) used.

4. Weigh out 9.74 g ± 0.10 g of sodium iodide. Then, quantitatively transfer the sodium 
iodide to the flask. Record the actual weight, manufacturer, and lot number of the 
sodium iodide (NaI) used.

5. Add 50 mL of isopropanol to the flask and swirl to mix the solution.

6. Allow the solution to cool, and transfer the solution to a 100 mL glass bottle.

7. Label the bottle 10 mM CsI, 25 mM KI, and 650 mM NaI in 50:50 IPA/H2O. In 
addition, label the bottles, as specified in step 2, step 3, and step 4.

Preparing the Working Calibration Solution

The working calibration solution used to calibrate the MSQ Plus Mass Detector can be 
prepared by diluting the stock solution 500-fold with a pre-mixed solution of 50:50 
isopropanol/water (v/v). 

To prepare the working calibration solution

1. Prepare approximately 250 mL of the 50:50 isopropanol/water (v/v) diluent.

125 mL Erlenmeyer flask (or equivalent) 1

250 mL plastic graduated cylinder 1

1 mL adjustable, mechanical pipette (calibrated) or equivalent 1

Analytical balance 1

Table 12. Materials and equipment required to prepare calibrant (Sheet 2 of 2)

Materials and equipment Quantity
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2. Unscrew the cap of the reference reservoir bottle, and remove the bottle from the MSQ 
Plus Mass Detector. 

3. Dispose of any leftover calibrant solution from the reference reservoir bottle, and rinse the 
reference reservoir bottle with 50:50 isopropanol/water to remove any remaining residue.

4. Add approximately 100 mL of the premixed 50:50 isopropanol/water (v/v) to a 250 mL 
plastic graduated cylinder.

5. Using a 1 mL adjustable, mechanical pipette (calibrated) or equivalent, add 0.5 mL of the 
stock solution [10 mM CsI, 25 mM KI, and 650 mM NaI in 50:50 IPA/H2O (v/v)] to 
the graduated cylinder.

6. Fill the graduated cylinder to the 250 mL mark with premixed 
50:50 isopropanol/water (v/v).

The working calibration solution contains 1.3 mM NaI, 0.05 mM KI, and 0.02 mM CsI 
in 50:50 isopropanol/water.

7. Transfer the calibrant solution to the clean reference reservoir bottle. Then reinstall the 
reservoir bottle into your MSQ Plus Mass Detector. Ensure that the bottle cap is tightly 
closed. See Figure 76.

Figure 76. View of refilled reference inlet reservoir 
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Thermo Scientific MSQ Plus Mass Detector Getting Started Guide 109



Index: S
Roadmap view  18
Run Sample icon  82
Run Sequence dialog box  82

S
safety precautions  xiv
safety standards  iii
Save As dialog box  71, 79
Save Tune Parameters dialog box  46, 55
scan events  70
Scan menu  64
Select Tune Parameter File Name dialog box  42, 51
Select Tune Raw File Name dialog box  42, 51
sensitivity test solutions

erythromycin  101
p-nitrophenol  102
preparing  99

sequence file  81
Sequence Setup icon  75
Sequence Setup view  75, 77
sequences  75
serial number of the mass detector  13
Server icon

appearance on starting Xcalibur data system  18
states of  17
status of MSQ Plus Mass Detector  17

Server shortcut menu  27
server software  17
Show Full Scans bar  60
Show Method Options bar  60, 67
Show Per Method Parameters Table bar  62
Show SIM Scans bar  60
SIM scan events  63
SIM Scan Events table

opening  58
parameters on  68
purpose  63
switching to Full Scan Events table  60

.sld files  81
source fragmentation  63
spectrum view  61
Start Acquiring icon  44, 54
Status Log report  95
Stop Acquiring icon  44, 46, 54

T
Thermo Foundation Instrument Configuration dialog box  
12

triethylamine (TEA)  6
trifluoroacetic acid (TFA)  6

tune files
saving optimized settings in  8
selecting in Method Editor  68

Tune Method report  96
Tune Options dialog box  29, 41, 50
tune report locations  37
tuning calibrant  27
tuning in APCI mode See atmospheric pressure chemical 
ionization

tuning in ESI mode See electrospray ionization
turbomolecular pumps  2

U
Unlocked icon  85
USB cables  18
UV detectors  1

V
vacuum system  2
View bar  66
volatile buffers  6

W
waste bottle  26
WEEE compliance  v
Welcome page  57, 66

X
Xcalibur data system

anti-virus software  16
communication iwth MSQ Plus Mass Detector  17
Information view  17
Instrument Setup view  40, 49, 65
parameters imported form tune file  8
Roadmap view  18
Sequence Setup view  75, 77
server software  17
starting  18

Xcalibur icon  18
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